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Preface

This lab manual explains the procedures that you will need to carry out your project in
8.287J-12.410J, Observational Techniques of Optical Astronomy. These procedures include the
preparation of star charts ("finder charts"), how to find objects with the telescopes at Wallace
Observatory, instructions for using the instruments and corresponding software to record
astronomical data, and directions for using the course software to reduce the data. This manual
includes several "tutorials," which give step-by-step instructions for the described procedures,
with samples of the results that you should be getting with each step. These should enable you to
carry out the procedure —and simple variations of the procedure—on your own. Although some
explanations of the general principles behind each procedure are given, the principles are
explained in the course notes and in the lectures. Some sections of the lab manual have an
exercise that follows the tutorial, which gives you an opportunity to test yourself. Finally, we
have included some Appendices with reference material that you may find useful.

Be aware, however, that software and the observatory equipment continually changes,
and keeping this manual up to date is a challenge! If something does not work as explained
herein, first carefully check that you have followed the instructions to the letter. If you still have
the problem, report it to the teaching staff. If the resolution of the problem calls for a correction
or other revision to this manual, send it to Professor Elliot (jle@mit.edu) to spare future students
from having the problem that you experienced. Happy observing!

You should bring this manual to each lab section.
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1 Constructing a Star Chart (" Finder Chart")

To identify objects while working at the telescope you will need a star chart, which is
commonly called a "finder chart" in astronomical work. It is absolutely essential to have good
finder charts when trying to locate an object in the sky at the observatory. The pointing accuracy
of the manual-slew telescopes is nowhere near good enough to simply dial in the correct
coordinates and expect to be pointing at the correct object, unless perhaps your object is the
moon. The pointing accuracy of the more automated telescopes can be quite good, if properly
calibrated, yet it is still necessary to create a finder chart so you can confirm that the telescope
pointed correctly. It's stomach-dropping to realize, several days later when reducing data, that
you took 7 hours of data in finger-numbing 15° F weather on the wrong object, which was only
15 arc minutes from the correct object!

Here we describe how to make a finder chart in three different ways: (1) with a program
called Starry Night Pro, (available on the Macs in the astronomy lab in 37-292, the Lindgren
Library, and at Wallace Observatory) (2) with a program called XEphem, (provided by Athena),
and (3) with the VizieR online catalog, which runs on any computer with an internet connection
and Java Runtime environment. The similarities and differences are outlined below.

Both Starry Night Pro and XEphem are excellent programs to make simple finder charts.
Starry Night Pro is useful for constructing star charts of well-known objects quickly and clearly
because you can save certain attributes such as the location of Wallace Observatory, the field of
view (FOV) finderscope, eyepiece, and CCD, so you do not need to reset them the next time you
use Starry Night, provided that you use the same computer.

XEphem i1s great for constructing slightly more detailed finder charts because the program
has a lot of unique features. First, it can invert any star chart you construct to match the simulate
the mirror-flipping of the image in the telescope. It also allows you to download any catalog of
celestial objects available online, so you may construct finder charts for fainter or newly
discovered objects. Lastly, it runs on Athena allowing you access it from any cluster on campus.
However, this also means that you need to reset attributes, such as the location of Wallace and
the eyepiece FOV, every time you use the program, which may take extra time. Both Starry
Night Pro and XEphem have a feature that obtains target information from online databases that
are updated daily. However, the databases are limited, and consequently, these programs cannot
display lesser-known objects, such as 16" magnitude stars.

The VizieR online service is a compilation of many star catalogs and is very useful for
making detailed finder charts. VizieR will even display stars whose magnitudes are well beyond
the detecting capabilities of the shed telescopes at Wallace. However, if your object is faint, it is
always a good idea to supplement your simple finder charts with more detailed ones in case the
night is particularly clear and your Starry Night chart is not sufficient. See Appendix C for the
link to the VizieR website.

1.1 Starry Night Pro (available on select Macs in the lab and libraries)

Starry Night Pro is the primary program that we support for making finder charts and
planning your observations. It resides on the Macintosh computers the astronomy lab, the
Lindgren Library, in the main building at Wallace Observatory. You can download a trial version
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for your own computer at the URL
http://www.starrynight.com/digitaldownload/trial download.php if you are
interested. Here we explore some common tasks one might use this program to accomplish.
The program has many more capabilities than those described below, and the teaching staff
encourages you to explore these additional features on your own.

Starry Night is primarily used to synthesize what you expect to see at the telescope before
you are actually there. For example, if you want to observe the Andromeda Galaxy from Wallace
during your lab section, you can create a chart that will allow you to determine (1) if the
Andromeda Galaxy is above the horizon during your lab section and (2) how to find it in the sky.
To do this, you can simulate your expected observing situation by setting the conditions on
Starry Night accordingly. To do this you need to set your location on Earth and the time you
expect to be looking at the sky. You will also want to know how to find and center an object on
your screen in the simulated sky once you are situated.

When you launch Starry Night, you may see something similar to the window displayed
in Figure 1:
0 C untitledl o'

& 8/1 2 AD  8:2 9 AM 1 4 ¢ B B 2 v A vWallace Observat... L() ﬂ

Aisann J adodsajay J AO4 1 Jauuelg J ojup J smels 1 salunoAey J suondo J pud |

Figure 1. Sample of Starry Night main screen upon launch. See text for description of
program.

In order to move around and execute commands in Starry Night, the cursor must be
appropriately defined. The box in the top left-most corner (it has an arrow in the picture above)
allows you to change the cursor functions as you move around within the program: adaptive
(chooses one of the following cursors depending on what the program thinks you want to do) —
angular separation (find the angular separation in the sky between two objects) — arrow (for
selecting objects in the display) — constellation selector (select the nearest constellation to where
you click in the display) — hand (scrolling in the display)- QTVR tracker — location scroller
(change your location on Earth as you scroll) — magnification (zoom in and out).
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1) Set the location: To the top right in the above image you should see the words “Wallace
Observatory”. You can change your location by clicking on this pull-down menu and
scrolling down to “Viewing Locations—Other”. Once here, you can set your location
by (a) selecting a location from the list, (b) selecting the “map” tab, then clicking on
the map, or (c) selecting the “latitude/longitude” tab and typing in the latitude and
longitude of where you want to be (for Wallace this is: +42° 36.6° N, 71°29.1" W).

2) Set the Date/Time: The date and time is defaulted to be “now” when you first open the
program. You can change the time by clicking on the pulling down and selecting one
of the options, or by clicking on the part of the day or time you want to change and
simply typing your new values with the keyboard.

1) The button next to the time that reads “1x” can be modified to any time increment you
desire via the pull down menu to the right of the number. For example, you might
speed up time to see what will happen to your object over the course of a night, or
to see when the moon comes up in comparison to your object.

i1) Time can be run forwards or backwards with the five buttons to the right of the time
increment.

3) Find an object and center it in the chart: On the left hand side of the screen (Figure 2) there are
a series of menus (find — options — favorites — status — info — planner — FOV —
telescope — livesky). Click on “find” and the tab bar will slide open. Type the name of
the object you want to find in the box at the top and press enter. A list of possible
matches to your inquiry will be displayed below where you typed. To center one of
these objects, click on the arrow to the left of the name and scroll down to “Centre”.
Your object will then be centered on the screen. If your object of interest is below the
horizon you will be asked if you want to reset the time to the “best time” — this is
defined to be the point at which the object is highest in the sky — or “hide horizon”.
Select one of these. You can zoom in on your object by sliding the bar on the top
right of the display where the little pair of binoculars is located.
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Figure 2. Sample of Starry Night screen to search for and center on the Andromeda
Galaxy, M31. See text for how to create this screen.

If you want to get information about your object of interest, click the “info” tab below the
“find” tab. Information relevant to the object’s observational circumstances are displayed in
addition to a brief description about the object itself.

There are various other menus and tabs (Figure 3) that allow you to set viewing
parameters (coordinate systems, constellation overlays etc.) and to get other information relevant
to your object or field. You are encouraged to explore these on your own.
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Azimuth: 296° 15.796'
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v General

Export: | Save Info...

Looking: north west (296 degre...
36 degrees from horizon
Field of View: 100 degrees (width)
90 degrees (height)
Limiting Magnitude: 6.4

v Time

Universal Time: 8/18/2004 12:38:34
Local Time: 8/18/2004 8:38:34 AM
Julian Day: 2453236.02679

Sidereal Time: 5h 43m 26.5s
Delta T: 78.9 seconds

¥ Location

Location: Wallace Observatory, U...
Latitude: 42° N
Longitude: 71° W

Heliocentric X: 0.83815 au
Y: -0.56732 au
Z: 1777 km

Distance from Sun: 1 552F0au
Angle fro...liptic Plane: 2.42308-areseconds
Phi: 325.91 degrees

» Hertzsprung-Russell

» H-R Options

Aysann J adodsajay J AO4 J Jauuelg J ol | smeis ‘ sajunoaey j suondo J puis |

Figure 3. Sample of Starry Night tab menus of interest (left to right): Info, Options and
Status. See text or Starry Night help for additional information on the contents of these

tabs.

If you want to find an object by its coordinates rather than its name, click on the “edit”
menu and scroll down to “center on...”. A dialog box will appear where you can type in the

coordinates of your object.

You may also want to overlay field of view (FOV) boxes on the display to determine
what stars you should expect to observe through the finderscope (Figure 4), the main telescope
eyepiece, or the CCD (charge-coupled device, for more information see section 3). Click on the
FOV tab and checking the box next to the FOV(s) of interest. More than one box can be displayed
at a time. You can define new FOVs here as well if the one you want is not already in the

database.
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LY @ 4 4 m > B 2 v A vWallace Observat... L © él’g

You don’t have any telescopes in your
equipment list. Select “Edit Equipment
List..." from the Edit menu to add

telescopes.

v Finderscopes | Edit... |
cco =
MagIC =
Finderscope [}
Eyepiece =

» Binoculars | Edit... ]

» Other (All charts) | Add... |

» Other (This chart) (CAdd... )

Aysaan ] adoasajayL ]/\o_q Jduue|d ] ojul l smeis } S1IN0ARY [ suondo ] puiy

Figure 4. Sample of Starry Night screen for FOV overlay of finderscope, eyepiece and CCD
on a region of sky over the object of interest, in this case, the Andromeda Galaxy, M31. See
text for how to create these overlays.

To print a copy of your finder chart go to the "file" menu and scroll down to "print"
(Figure 5). You can either print to the printer directly or print to a .pdf file. The file will print
black stars on white so as not to waste black ink. The printout will cover the area visible on your
computer screen plus a little more of the surrounding sky.

k )+ ; o—a

¥ Guides
Show compas...»
¥ Alt-Az Guides
Equator
Grid
Meridian
Poles

p Celestial Guides

Summer/Winter !

Vernal/Autumna

(NGE 457)

¥ Ecliptic Guid...rid, Eq/

—Axes E—

1
-

Equator
Grid

Aysann | adodsajar | A04 | sauueld | oy

Meridian
Poles
p Galactic Guides (i ]
P Extra-galactic Guides (i}
32

- 137

¥ Local View |

Daylight

Nocth Ameridan Nebula (NGC 7000)»

Local Horizon

Local Light Pollution

> Distant Light Pollution
¥ Solar System | %v |
Asteroids Labels

Figure 5. Sample of Starry Night screen for printing. Select “save as PDF” to save to a
file.
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1.2 Xephem (Athena computers)

XEphem is an excellent, free ephemeris program that can be used to simulate sky views,
create and print finder charts, and do just about everything you need to do to prepare for your
observations in this class. You can find more information about XEphem, and download it, at the
XEphem website (http://www.clearskyinstitute.com/xephem/). XEphem runs on
UNIX (e.g., Linux and Mac OS X), but not Windows. It is already installed on Athena.

This tutorial describes how to run XEphem on Athena, configure it, view the sky, locate
objects, load catalogs, and create finder charts. It was written when version 3.5.2 of XEphem was
current. If you are using a different version, some of the details presented here may differ,
although the general principles should be the same.

1.2.1 Starting XEphem on Athena

Login to Athena. If you are on a non-Athena UNIX computer, access Athena with ssh:
ssh -X username@x.dialup.mit.edu

where "username" is your Athena username. You will be prompted for your password. If your
local SSH is so configured (and it probably is), graphical programs started on Athena (such as
XEphem) will display on your local machine.

XEphem is in the "xephem" locker on Athena. To add the locker, type the following at a

command prompt
athena% add xephem

This will attach the filesystem containing XEphem and allow you to run it. To run it, type
athena% xephem

at the command prompt. If the latest version of XEphem hasn't yet been compiled for the
architecture you are running on (and it very well may not be), you will receive a warning, and
will have to run an older version, such as "xephem-3.4". As of August 2008, both standard
Linux and Sun Athena platforms had working versions of XEphem.

A window similar to Figure 6 should appear on your screen (left panel):
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Local CST Calendar Local \ UTC-5S Calendar
Chicago, I1linois || December 2003 Wallace Observatory December 2003
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Elevation: 181.4 ml| - Elevation: 107.0 m| !
Temp: 10.0 ¢J| 577 Temp: 10.0 ¢l 211
Atm Pres: 1010 va; Atm Pres: Vijﬁﬂjﬂnmmg_f
Equinox: 2000.0/ | Equinox: 2000.0 ‘
Time & ‘ Night Time || Night -
Julian: 12452987.46792||| Sun Dip: 18°] Julian: 12452987.49417||| Sun Dip: 18°|
UTC Date: 12/13/2003]|| Dawn: 5:29 UTC Date: 12/13/2003]| Dawn: 5:25
UTC Time: 23:13:48|| Dusk: 18:00 UTC Time: 23:51: 36| Dusk: 17:55
Sidereal: 22:52:08| Length: 11:29 Sidereal: 0:34:39// Length: 11:31
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TZ Offset: 6:00:00)| —1]+1| Looping  Mowi| TZ Offset: 5:00:00/ 4j+1] Looping  Now|
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local Time:  17:13:48|| N Steps: 1| Local Time: 18:51:36)| N Steps: 1]
Delta T:  (Auto) 67.42] pause: ol Delta T:  (Auto) 67.42| pause: 0|
Update \ Update \

Figure 6. XEphem location, time and date window. The left panel shows the main XEphem
window with its default location set for Chicago, Illinois. The right panel shows the main
window updated for our use with the location set to Wallace Observatory.

1.2.2 Setting Your Location

So that XEphem will produce the appropriate sky views, you must give it your observing
location and the appropriate time of your observations. This information needs to be entered in
the "Local" pane of the main window, as shown in the upper left corner of the panels above.

Wallace is unfortunately not in XEphem's list of observatories, so you will have to enter
its information manually. To do this:

1. Set each variable in the "Local" pane by clicking on the values and manually
entering them. The latitude and longitude of Wallace are +42°36'36"N and -
71°29'06"E, respectively. The elevation is 107m.

2. Save the name of the custom-defined location by clicking on the location button.
3. [Edit the text.

4. Click the "set" button on the left, and then click "Close".

After setting the values, and optionally naming your location, your window should look like the
image on the right-hand panel above.

Once you close the window that saves the information you have entered, Xephem will
flash the words "NEW CIRCUMSTANCES" near the top of the window until you click the

"Update" button at the bottom. This button tells XEphem to use the values that were just
changed.
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You can set the date and time to any value (not just the current date and time) in the
upper right and lower left panes respectively. This is helpful for creating finder charts for
planning future observations and is particularly useful for planning observations of asteroids,
which can move several arcminutes per night. You should also be sure to set your timezone in
the lower left panel.

1.2.3 Turning on Field Stars

XEphem comes with a fairly small catalog, including only very bright stars, planets, and
some other bright objects. To do serious observing, you need to know the locations of relatively
dim stars near your target object. The Hubble Guide Star Catalog (GSC) contains approximately
19 million stars in the magnitude range 6 to 15. As you can imagine, the catalog is quite large in
file size. XEphem can be configured to download from the web only the GSC stars in the region
of interest. This is convenient, because it requires downloading information for just a few stars,
instead of the whole catalog. On the other hand, it requires being connected to the web when
using XEphem. To configure XEphem to download GSC stars (Figure 7), from the main XEphem
window:

I. Go to "Data -> Configure Field stars...". A dialog window should
open.

2. Check the box labeled "Internet to xephemdbd"

3. Click "ok"

Hubble Guide Star Catalog, GSC:

1 ASP CDROM Directory: /mnt/cdrom

I local Cache Directory: ifopt/xephem/catalogs/gsc

" Internet to xephemdbd: thttp://clearskyinstitute.com/cgi-bin/xephemdbd/xephemdbd.pl
JInternet to ESO

USHNO A& or SA catalogs:

IRoot directory: i/opt/xephem/catalogs/usno

Proper Motion catalogs:

_IPPM catalog: {opt/xephem/catalogs/ppm. xe2

AHipparcos + Tycho2: {opt/xephem/catalogs/hiptyc2.xe2

" Skip likely duplicates
Ok | Apply . Close Help

Figure 7. XEphem window for source locations of star catalogs. See text for details of how
to modify these catalogs.

1.2.4 Viewing the Sky
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From the main window (Figure 8), go to "View -> Sky View...", and a new window should
appear:

Contro] Images Locate Telescope H1st0ry ) ﬂg}pf
6 [E o[ Ea [Of=

9

E]

A [ -

How » Em@ @

FOV: 180:00 Az: 180:00 Alt: 90:00
90H| 1:1]2:1] 12/13/2003 18:55:15 UTC-S —45:00| 0: 00/ 45: 00|

Figure 8. Sample of XEphem screen of sky view on startup. See text for description of the
side menus and their intended uses.

The slider on the left will zoom in or out, decreasing or increasing the field of view. As
you zoom in, a small dialog window will pop up that reads "Press stop to cancel..."as
it downloads GSC star information from the web. The sliders on the right and bottom will
change where you are pointed in the sky in either ALT-AZ or RA-DEC coordinates. To switch
between ALT-AZ and RA-DEC modes, click on the box on the left that looks like two axes. The
light bulb buttons on the left will adjust the magnitude range of stars shown in the field of view.
The left-right arrow and up—down arrow buttons will flip the image along the vertical and
horizontal axes respectively.
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Control Images Locate Telescope History 7 ﬂe}p[

[B oot i 2 [©]#]8 ],

¥ ,
Jupiter
g | 1 Jupiter
“'— Planet
~§§J : Date: 12/13/2003
Time: 22:24:40

Rise: 23:10
z_..__L' 3 Transit: 5:37
@ : B Transit Alt: 53:07
| v - Set: 12:01
i_ - R&: 11:18:14.13
L ; : 2 Dec: 5:43:01.1
~>| Alt: -—-8:49:27
ozl i 3 : fz: 73:46:56
X R : 2 Mag: —1.93
) Size: 37.5"
= Center
=
L2 : Center + Zoom
Place eyepiece
ABVSO
Show in Data Table
Persistent Label
Track
Create Trail...
; '\
FOV:_ 7:35 RA: 11:18:14 Dec: ‘ 3:357
90H| 1:1]2:1] 12/13/2003 22:24:40 UTC-5 _—45:00] 0:00] 45: 00|

Figure 9. Sample of XEphem screen for display of object selection and object information.
Right-click on any object to get the displayed information for that object.

Right-clicking on an object will give you information about it (Figure 9), including its
name, what type of object it is (e.g., star, planet, space station), when it rises, when it transits, its
altitude at transit, when it sets, its RA and DEC, ALT and AZ, magnitude, etc.

1.2.5 Locating an Object

To locate a particular object in the sky view, go to the main window, and select "Data ->
Search memory, define ObjX,Y,Z...". You should see a window simliar to that found in
Figure 10.
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Control Images Locate Telescope Histor: ﬁe]pf

PSS E =)

“Undefined < Hyperbolic| <> 0bj¥%| Achernar
Fixed Parabolic | Objy | Alcor
Elliptical Earth Sat | objz|Aldebaran
' ; - Algol
Altair
fnd 2
and 3
and 4
And 5
and 6
and 7
fnd 8
and 9
and 10
And 11
and 12
and 13
fnd 14
and 15
and 18

Search:

Sky Point| Sky Mark| Tel Goto

a
FOV:  1:00 RA: 18:36:56 Dec: 38:47 0k Apply Reset Close Help
90H| 1:1]2:1 12/13/2003 18:55:15 UTC-5 ~—45:00]0:00/45: 00|

Figure 10. Sample of XEphem screen for locating an object (left) and the sky view screen
after you have selected and centered on that object (right). See text for more details.

The list of objects on the right of the rightmost image above represents all objects
XEphem currently has loaded into memory. You can either scroll through the list, or use the
search box beneath the list. Once you select an object, click on "Sky Point" to center the sky
view on that object. Make sure you are zoomed in and that the object of interest is not already in
the field of view. Otherwise the sky point command will not do anything. For example, the sky
view of Vega might look something like the left-hand panel above after you have clicked on
“sky point”.

As you can see from the lower left of the starfield, where it says "Fov", the field of view
for this sky view is 1°. There are many stars in this field of view. By default, some of the brighter
stars are labeled, e.g., GSC 3105-1382, however, this parameter can be user defined.

1.2.6 Adding Catalogs

So far, XEphem should only have its small default catalog loaded, and should be
configured to download the field stars it needs from the GSC. If the object you are interested in
observing is not in these catalogs, then you will need to download and load the catalog
containing your object. For example, if you are observing an asteroid, you can tell XEphem to
download the latest updated asteroid catalog from either Lowell Observatory or the Minor Planet
Center. In the main window, go to "Data -> Download Internet files...". A window
similar to that found in Figure 11 should appear.
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Download a file containing .edb or TLE formats:
Get| thttp://celestrak. com/NORAD/elements/stations. txt
Get|thttp://celestrak. com/NORAD/elements/science. txt
Get| thttp://celestrak. com/NORAD/elements/t]e—new. txt
Get| http://cfa—ww. harvard. edu/iau/Ephemerides/Comets/Soft03Cmt. txt
Get| thttp://cfa—wm. harvard. edu/iau/Ephemerides/Critlist/Soft03CritList. trt
Get| thttp://cfa—ww. harvard. edu/iau/Ephemerides/Distant/Soft03Distant. tyt
Get| thttp: //cfa—ww. harvard. edu/iau/Ephemerides/Unusual /Soft03Unusual . txt
Get|:
iSearch during download for i

.edb or TLE spec:  Erase| Assign to: obj¥| obj¥| Objz|

Download large daily epoch asteroid data set:
Get| from Minor Planet Center, saved in AstMPC.edb and AstMPC_dim.edb

Get| from Lowell Observatory, saved in Astlowell.edb and Astlowell_dim.edb

Close Help

Figure 11. XEphem screen for adding star and moving object catalogs. See text for how to
modify these catalogs.

Clicking on the "Get" buttons on the left will download the corresponding catalogs. You
can even download a catalog of space stations! The two buttons near the bottom will download
and compile asteroid catalogs. However, to use these, you need to have two supporting file
already on your machine, "astorb2edb.pl" and/or "mpcorb2edb.pl" and defined in your
path. If you don't have them, do a Google search to find them on the web, download and:

1. make them executable:
chmod u+x astorb22edb.pl mpcorb2edb.pl

2. put them in your path
mv astorb2edb.pl mpcorb2edb.pl ~/bin/

3. The last step assumes "/mit/username/bin" is in your path. It may not be
unless you put it there manually. To do so, put the following line in your
".cshrc.mine" file in your home directory:
set path=($path /mit/username/bin)
where "username" is your Athena username.
4. Log out and log back in for the changes to take effect.
If you are confused by the steps above, Athena help should be referenced for clarification.

After you download a new catalog, you need to tell XEphem to load it into memory. To
do this, in the main window, go to "Data -> Load/Delete local files...". A new
window should appear showing a list of the types of objects already loaded, the names of the
catalogs loaded, and a button for choosing other files near the bottom of the screen for the
catalog file you are attempting to load. The two buttons on the bottom right, "Shared Dir" and
"Private Dir", take you to the system default XEphem data directory, and your private
XEphem data directory, respectively. If you have downloaded any of the catalogs above, such as
an asteroid catalog, they will be in your private directory, and will be shown in the file chooser
once you click on "Private Dir".
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1.2.7 Making Finder Charts

Before creating a finder chart, it is important to keep a few key points in mind. First, the
telescopes at Wallace are equatorially mounted, and the CCDs mounted on them are aligned with
the equator. This means that the vertical axis in a CCD frame is aligned with declination, and the
horizontal axis is aligned with right ascension. Therefore, if you create your finder charts with
RA-DEC alignment, it will reduce one unknown when you are trying to match up stars seen in
the CCD with stars on the finder chart, namely the rotation angle. Second, the view through the
eyepiece of a telescope is the mirror image of the view with the naked eye. The CCD image may
also be mirror flipped with respect to the eyepiece view. Therefore, it is useful to create finder
charts with all four possible mirror flips. Third, it is vital to know the scale of what you're
looking at through the finder scope, the eyepiece, and the CCD. The dimensions for all of these
are listed on the Wallace website and in Appendix B. You can use these dimensions to draw the
appropriate circles and rectangles representing these views and overlay them on the sky view and
your printed charts. Fourth, finder charts should show the sky as it will appear at the date of time
of your observation. You should change the date and time on XEphem in the main window to
match those of when you will be observing, and then click on "Update".

XEphem can store and use several eyepieces at a time. To define an eyepiece, in the sky
view, go to "Control -> Eyepieces...". You will see a window that looks like the panel on
the left of Figure 12:

Set next eyepiece size, shape and style: ‘ Set next eyepiece size, shape and style:
W 0:50 W 0:08
H 0:50 H 0:06

A lock scales together Ilock scales together

Create a Telrad pattern ICreate a Telrad pattern
Shape: 4E11iptical Style: . solid Shape: _ E1liptical Style: _ solid

«Rectangular “outline “Rectangular “0utline

Handy Field-of-View Calculators: Handy Field-of-Wew Calculators:

Focal length  F Plane Size Sky angle Set Focal length F Plane Size Sky angle Set

{mn) m in () mm in D:M:S W {mn) m in (um) mm in D:M:S W
S0rmm £35mm 40:03:20.0 H S0nmm 235mm 40:03:20.0 H
Apparent Eyepiece Mirror FL Apparent Eyepiece Mirror FL

FOv, FL, mm  (mm) m in W FOV, = FL, rm  (mm) m in W
45 42mm 2000mn 0:16:12.0 H 45 “12mm 2000rm 0:16:12.0 H
Save Favorite Eyepieces: add Save Favorite Eyepieces: Add

Del| Use|/Station 4 CC 0:08 0:06 R O

Delete all Sky Wiew eyepieces

Close Help Close Help

Figure 12. Sample of XEphem screen for defining FOV overlays to place on the sky view
screen centered on your object of interest. See text for how to modify these parameters.

The sliders at the top define the width and height of the eyepiece, in degrees:arcminutes.
You can set the shape to either elliptical (circular if the width equals the height) or rectangular.
Once you define an eyepiece, click the "add" button near the bottom to add the eyepiece. It will
appear below the add button, where you can name it, as demonstrated above in the right panel.

The "Del" button to the left of the eyepiece will delete an eyepiece. The "Use" button
selects the eyepiece that XEphem will use when any eyepiece-related action is performed in the
sky view. Click the "Use" button to select the eyepiece you've created. In the sky view, center
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your object of interest, then right click on it and select "Place eyepiece" to draw the current
eyepiece. You may have to zoom in or out to see the eyepiece. Figure 13 shows a sky view of
Beta Lyrae with the CCD for the telescope in bay 4 overlaid in red:

Help |

Control Images Locate Telescope History

6 EeEFER ©

Title:
[

» Color
~ Grayscale

4 Save to file: i/home/fregeau/XEphem/xephem.ps
+ Print command: {1pr

0Ok Cancel | ~ Help

FOu: 0:10 ‘ RA: 18:50:05 Dec: 33:22J
1]2:1 12/13/2003 18:55:15 UTC-5 —45: 00/ 0:00/45:00

Figure 13. Sample of XEphem sky view with FOV overlay (left) and sample of print screen
(right). See text for how to generate these windows.

Note that the orientation is RA-DEC, and not ALT-AZ. The broken yellow line through
the image is simply a constellation connector, and can be turned off by clicking on the button
near the top with the dots connected by lines. As mentioned before, you might want to print
finder charts with all four possible mirror orientations, to ensure you get the right orientation for
your telescope and CCD. Use combinations of the two buttons on the lower left, the left-right
and up-down arrows, to get all possible orientations. After you observe once, you will learn
which orientation to use for the finder, eyepiece, and CCD, and will only need to print the
appropriate one. It never hurts to print more charts than you really need.

To print, in the sky view, go to "Control -> Print...", and you will obtain the print dialog:
You can either print directly to the printer, or print to a postscript file. You can also add a title to
your printout. The sample finder chart printout for Beta Lyrae is found in Figure 14.
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Information relevant to your observations is printed at the bottom of the page, including
the orientation of the view (which direction is North and which is West), the scale, and the

Beta Lyae

®
-
2
_*II 332500
7
/
* GSC 264211 o4 -
L ] {
l'l
!
f
{
/
30
a ®
.
.
18 3 G50 264201
17 L
16
* 15 % E
- 14 f‘q -
® 13 A17-00
— e [
XEpham Topocentric Mean RADec Sky View
Walboce Okeanvatory
RA: 18:50:04.8 Julan Date: 2452987 49670
Declination: 33:21:46 North & up - West &= right Sidereal Time: 038:19
Epoch:  2000.00 Grid Steps: UTC Date: 12132003
Alttude:  23:62:39 RA: 0:00:05 UTC Time: 23:86:15
Azimuth: 294:14:17 Dec: 0:01:00 Latitude: 42:36:36 N
Field Width: 0:10 Eyepieca: 0:08 x 0:.06 Longitude: 71:29:06 W

Created by XEphem Version 3.5.2 8 Jan 2002
Copyright () 1990-2002 by Elwcod Charles Dawney
:!www. ClearSkylnstitute com
Generated Sun Dec 14 02:03:58 2003 UTC

observing date and time.

1.2.8 Conclusions

This tutorial only scratches the surface of XEphem. It has an impressively wide range of
useful capabilities that the teaching staff encourages you to explore on your own.

1.3 VizieR Online Service

As mentioned before, VizieR can be accessed from any computer with an Internet
connection. In addition to making finder charts, VizieR can also be used to find positions of
targets and comparison stars after you have taken your images, provided you have the names of
those stars. All it requires is the approximate celestial position of your object of interest.

1.3.1 How to Make Finder Charts Using VizieR

Figure 14. Sample of printed chart exported from XEphem.

Instructions on How to Make a Finder Chart (before observing)

1. Follow this link to the VizieR website: http://vizier.u-strasbg.fr/viz-bin/VizieR
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2.

Input the RA and Dec under “Target Name” in the format “hours minutes seconds
degrees arcminutes arcseconds”. For instance you would input “18 36 56.3 38 47 01~
in order to make a finder chart of Vega. If you don’t know the exact coordinates, put
in an estimate (although keep in mind that this will make the search more difficult).

T e e VILIGI S VILS
| < [| ¢ ||+ | & htp//130.79.128.14/viz-bin/VizieR (RsS]i(eS

[0 Apple (112)v Amazon eBay Yahoo! News (783)v Cambridge Weather VizieR Service

“ Clear * Find Catalogue )
Find catalogues or Data (tips and examples)

Find catalogues ¢ 6790 availabl

N ; 3 . L “ Find Catalogues )
Words matching author's name, word(s) from title, description, etc. N—
Select from Wavelength, Mission, and controlled Astronomical keywords: | Select from UCDs

Radio ANS 0 [AcN 6

IR ASCA Abundances

optical BeppoSAX Ages ) Use LISTs of Targets

uv CGRO Associations @ Show footprints

EUV COBE Atomic_Data Show all columns
X-ray Chandra 4| |BL_Lac_objects . = X .

Gamma-ray Copernicus v | | Binaries:cataclysmic M | Show column UCDs
Target Name (resolved by Simbad) or Position: Target radius: ‘ Clear )

14 1539.7 19 10 56 j2000  |%) 2 arcmin [3)

Position in ® Sexagesimal,or () Decimal ° ® Radius or () Box size “Find Data )

around Target
Search by Position across 6976 tables
Output preferences (usage)
Maximum Entries per table: Output layout: ALL columns p T
50 i HTML Table ™ Reset Al

Figure 15.

3
4.
5.
6

10.
I11.

labManual.6

Sample Vizier search for Arcturus

Change the “target radius” according to the dimensions of your field of view.

Choose your “Output layout” (the standard is HTML Table).

Keep all other settings the same, and hit “Find Data”

VizieR searches through a number of catalogs, and will display all catalogs that
contain objects within a certain radius of your input coordinates. It is possible that
many of these catalogs will have your target of interest (since a single object may
have multiple names, and therefore belong to multiple catalogs). Look under the 2™
column “r” which shows the distance from the coordinates you input to an object in
that catalog. Scroll through the entire page to find the target closest to your
coordinates. The USNO and UCAC?2 lists are generally god to use.

Once you have chosen an object, click on the corresponding link in “Full” (1%)
column. This link will lead to a Details page, which will give all sorts of information
on the specific target, including name and coordinates.

Click the “Aladin Image” link at the top of the page, and a detailed star field will
load. This may take a few minutes.

On the image, the target will be centered and marked with a + sign. You may click
on it to get the magnitude and position to make sure it’s the right object. You will
also be able to click on and get information about all other objects in that catalog in
the same star field.

To toggle the red dots on and off, click the eye in the upper right corner.

To get similar fields in different sizes, go to File-> Load Astronomical Image->
Aladin Image Server. Click “Submit” and select one of the images from the list. You
can also search for different RA/DEC coordinates from this window.
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R s Reole) VIZIER REsUNL Faye

| [ e[+ ] @ hup/130.79.128.14/viz-bin/VizieR-2 ~ Q- vizier

it [I] Tensioners A._.cable drive  MySQL/PHP tutorial Optica Soft...d Questions LensLab: En._.Mathematica Hyperboloid... MathWorld Massachuset... Technology

VizieR Result Page
L]0.1343]118 34 31.643][+35 39 42.87|[18 34 31.643]+35 39 42.87] 11.16[1938.948] 0.076] 0.215] 1243208 263600019501 0 684
2|[0.3542][18 34 20 260[[+35 39 42.42|[18 34 29.260([+35 39 42.42] 13.03][1949.461]| | [[1243203]

All-sky Compiled Catalogue of 2.5 million stars (Kharchenko 2001) (rReadMe)
The all-sky catalogue of 2.5million stars (2501313 rows)

[Full _r |[_RAI2000][_DEJ2000] RAJ2000 | DEJ2000 | Pix |[ e [pmRA|pmDE|Bmag[Vmag|SpType|TYC1[TYC2TYC3
| Z[0.1287][18 34 31.63][+35 30 41 527863179561 [+35.66157736-34.50[27.79 | -2.80][ -21.74][11.07210.630) | 2636] 193] 1]

The USNO-B1.0 Catalog (Monet+ 2003) (ReadMa)
The Whole-Sky USNO-B1.0 Catalog of 1,045,913,669 sources (1045913669 rows)

Il &

(17280 /ascco1 )

(y284/0ut)

Note: The USNO-B Catalog presents positions, proper motions, magnitudes un blue, red and infrared, as well as star/galaxy estimators for 1,045 913,669 objects derived from 3 648
separate observations. The data were taken from scans of 7,435 Schids plates taken from various sky surve s during the last 50 years.

USNO-B1.0 catalog was created by Dave Monet and collaborators at http /{www nofs navy mill

Note that the starigalaxy estimators may be mixed up in dense regions.

[Ful| _r |[_RAI2000|_DEJ2000|] USNO-B1.0 | RAJ2000 | DEJ2000 e RAJ2000[e DEJ2000|[Epoch/pmRA|pmDE|Ndet[Blmag|R1mag
J arcmin|| ‘h:ms" Ydimis” deg deg mas mas yr | mas/yr||masfyr mag | mag
| Zo-1280][18 34 31.63][+35 39 41 5]1256-0285133][278.631787 [+35.661520 0 of20000] -4 22 o 1107 1040
| 2[o.1611][18 34 30.27][+35 39 37.1]1256-0285122|[278.626145][+35 660303 544 99919925 0 of 2
| 2[0.1824][18 34 30 27][+35 39 34 6]1256-0285121][278.626137 [+35 639606 130 300(19755] -10] 26 5[ 15.11] 1226
4[0.1830][18 34 30.10][+35 39 41 .6][1256-0285120]278.625420[[+35.661567 572 99919925 230 174 3
3l[0.2587][18 34 31 60[[+35 39 54.7][1256-0285130]278.631653[[+35.665198 94 39419795  -10] 38 3] 1996
[ 8[0.2789][18 34 31.64][+35 39 26 2]1256-0285134|278.631839][+35 657278 770 469][1977.5 0 o 3 18.77
| Z[0.3483][18 34 32.70][+35 39 43 5]1256-0285142)[278.636262 [+35 662075 503 99519715 0 of 2 17.68
8[0.3559][18 34 29 25][+35 39 40 9[[1256-0285113|[278.621867|[+35.661370 202 129759 6 28] 5[ 1452 1274
9[0.3626][18 34 31.62[[+35 40 01 4] 1256-0285132|278.631750([+35.667056 667 5871978 4 0 of 3] 2025
| 10[0.3800][18 34 3287 [+35 39 42.1][1256-0285143|[278.636953][+35 661706 495 314[19715 0 of 2 18.11
| 12]0.4185][18 34 33 06][+35 39 42 6]1256-0283146][278.637734 [+35 661828 166 999(1971.9) 0 of 2 18.96
| 12[0.4207][18 34 3238 [+35 39 22 2][1256-0285139|278.634931|[+35 656170 107 89][1975.9 0 of 5[ 18.64] 1696
| £3]0.5204][18 34 29.16][+35 40 02 8]1256-0285112]278.621509[+35 667431 36 7219759 0 of 5[ 1848 17.09
14[0.5309][15 34 33 61][+35 30 43.1][1256-0285151]278.640034 [+35 661967 751 875/1969.9) 0 of 2 [ 1947
)

Figure 16. Vizier search results page. Click on the left column marked ‘“full” to get more
information about that star.

12. Print this image to use as a detailed finder chart to supplement your simpler ones. Go
to File-> Save the Current View-> JPEG

1.3.2 How to Use VizieR to find Positions of Comparison Stars (for Astrometry)

Suppose you are back in the lab and have an exposure that corresponds to the finder chart
you made using Starry Night. Your exposure consists of your target and a few comparison stars.
Since Starry Night only gives approximate positions, you would like to know the most exact
positions of your comparison stars in order to have reference values for your astrometry
calculations.

Instructions on How to Find Positions of Stars (after observing)

1. Find the names or ID numbers of the comparison stars of interest using Starry Night
and the approximate relative distances of your comparison stars to the target.

2. Follow steps 1-5 of Sect. 1.3.1 - How to Make Finder Charts Using VizieR for your
target.

3. A number of catalogs will come up. Using the names of your comparison stars
along with the relative distances to your target, decide which stars listed are those
that you are looking for.

4. Follow steps 7-9 of Sect. 1.3.1 - How to Make Finder Charts Using VizieR in order
to find the comparison star positions.
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2 Finding an Object with the Telescopes at Wallace Observatory

In this section we discuss how to use the telescopes at the George R. Wallace, Jr.
Astrophysical Observatory to find objects in the sky, and to center them in the eyepiece of the
instrument. This process is essential, of course, prior to making any astronomical measurement.

The telescopes available to you are permanently mounted in the “shed” and include:
One 14-inch telescope with a spectrograph (bay 1)
One 11-inch telescope with a CCD camera (bay 2)
Two 14-inch telescopes with CCD cameras and automated mounts (bays 3 & 4).
(These can be used at Wallace, or occasionally remotely from the astronomy lab in
37-292. See class announcements for remote observing opportunities.)
One 16-inch telescope with a CCD camera in the smaller of the two domes.
Additional 8-inch telescopes with CCD cameras that can be set up in driveway if needed

More information about these telescopes and instruments can be found at the URL
http://web.mit.edu/wallace/

2.1 Operating the Wallace Shed Telescopes

All the telescopes in the shed are set up in what is called “Polar alignment”. This means
that the axis of the telescope is along the same line as the Earth's rotation axis, which is within
one degree of the north star, Polaris. The telescopes pivot around this axis and have a motor that
tracks the sky’s motion in the east-west direction so that once you point at an object it does not
run out of the field. When you start the night you will need to do the following:

1. Take all the lens covers off of the telescope.

2. Turn the power strip on the telescope pier to “on”.
Push the power button on the computer (little button on the top right of the back of the Mac Mini
computers) and let it boot. You should see a number of lights at this point: the power lights from
each of the power strips (one on the pier, and one on the desk), as well as the USB hub light. You
should also hear the fan on the CCD camera. If any of these fails to light, or you do not hear the
fan turn on there may be power/connection problems, and you should discuss this with your TA.
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Figure 17. 14-inch Celestron telescope set-up, the tube is to the left and the base is to the
right. Knobs, clamps and other things of interest are labeled.

2.1.1 The 14-inch Celestron manual telescope in Bay 1

Figure 17 pictures the base and side of the 14-inch Celestron. To move the telescope in
“Declination” (DEC) or the North-South direction, you need to loosen the clamp on the upper
right-hand side of the telescope (left picture above). Be sure when you move the telescope you
only grab onto it by holding the hand catches and the fork of the telescope. NEVER grab the
camera extension or the finder scope; this will be disastrous. Tighten the clamp when you
have moved to your desired location. To move the telescope in “Right Ascension” (RA) or the
East-West direction, you need to loosen the clamps at the circular base of the telescope (right
picture above). There are two clamps — one on each side of the base — you need to loosen both.
Again move the telescope to the desired location and tighten both clamps. At times you will want
to loosen both directions (DEC and RA) simultaneously and use the finder scope to locate the
patch of sky you are interested in finding. Once you get close to your object you can lock up the
telescope and use the hand paddle to search for and center your object with the fine adjustment
paddle motion than is feasible with the clamps free.

You will need several eyepieces for finding your field and recording data.

1. Use the Telrad and/or setting circles to point the telescope in the general direction
of the target (Figure 18)
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Figure 19. 14-inch Celestron telescope with Telrad (right), and with 40mm Plossl eyepiece

(left)

2. Use the 40mm Plossl eyepiece to locate the starfield and position the target near
the center of the field of view (Figure 18). Use the “F” speed on the Byers drive
handpaddle.

3. Use the reticle eyepiece to precisely center the target in the FOV. Use the “G”
speed on the handpaddle to position the object in the crosshair “box.” Note: you
will have to refocus slightly vs. the 40mm, but do not refocus once the reticle
eyepiece is focused. The fiber optic “eyepiece” is parfocal with the reticle
eyepiece so no further focusing is required

Figure 19. Reticle eyepiece (left) and fiber optic eyepiece assembly (right).

4. Once the target is centered, exchange the reticle eyepiece with the fiber optic
eyepiece assembly. If there is insufficient slack in the fiber, you will have to
rotate the diagonal (as shown in the figure) to a more “sideways” position — the
fiber optic requires a minimum 3” radius of curvature to function properly. Once
the diagonal is rotated you will have to reinsert the reticle eyepiece and re-center
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the target before inserting the fiber optic eyepiece. You can save yourself this
double swap if you anticipate a fiber limit and pre-rotate the diagonal in Step 3
above.

5. With the fiber in place, record your data with CCDSoft as described in Section
3.1.

6. Repeat steps 1 through 4 for each target.

Shutting down Pier 1:

1.

Note:

2.1.2

Re-insert the 40mm (with cover) in the diagonal. Place the capped fiber optic eyepiece
(on its side) on the top of the concrete pier to the right of the power strip. Check power
OFF on the reticle eyepiece and store it and the Byers handpaddle on the metal shelf next
to the camera and telescope drive power supplies.

Return the telescope to its stow position (the position it was in when you started the
night) and return all of its covers.

Port your data to titania

Turn off the power strip on the pier.

Always leave the eyepiece diagonal mounted on the telescope. If the telescope is pointed
to a low sky position, the diagonal may be rotated so as to facilitate viewing, however, do
not move/rotate the diagonal (or refocus the telescope) once the reticle eyepiece has been
lined up on a given target. Rotating the diagonal causes a slight image shift that may
move the target off of the fiber tip.

Telescope in Bay 2
This telescope is smaller than the other telescopes in the shed. You NEVER want to

loosen the clamps on this telescope, as it will lose knowledge of the direction in which it is
pointing. To move this telescope in any direction you MUST use the hand paddle (Figure 20).

labMar

1. Turn everything “on” as you would with any of the
other shed scopes. Lastly “boot up” the telescope by
pressing the power switch on the back of the telescope
base on the left side. Now look at the hand controller.
The controller screen will display: “Wake Up”
Press ENTER to wake from Hibernate, UNDO to exit.
Press ENTER.
The controller will display the current time, location,
and other information. Scroll through this using the UP
and DOWN keys (6 and 9 on the controller keypad) and
make sure this information is correct. If so, press
ENTER. If not, press UNDO and edit the information.
6. Once you have accepted the information, sidereal
tracking will turn on. Press the UNDO button until you
reach the top-level menu, the hand controller will
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display “NexStar GPS”. You can now begin using the goto features of the telescope,
move the telescope by hand with the four arrow keys, or move to objects using
TheSky6™ .

7. Open TheSky6™ , and link to the telescope using the green telescope icon. Unlike the
telescopes on piers 3 and 4, you do not need to home or park the telescope.

8. Sync the telescope using the hand controller (not TheSky6™).

Figure 20. 11-inch Celestron control paddle.

More detailed descriptions of how to find objects with this telescope can be found in the
manual next to the computer in Bay 2.

At the end of the night you must put this telescope into Hibernation mode so that it will retain its
alignment and the next person to use it wakes it up with it knowing where it is. To do this:

1. Unlink TheSky6™ using the red telescope icon.

2. UNDO to the top-level menu.

3. Press the MENU button (3 on the keypad), and scroll down to the UTILITIES menu.
Select the menu by pressing ENTER.

4. Scroll down again until you see HIBERNATE. Press ENTER. The controller will show:

“Position Scope”

“Move the scope to a convenient position, press ENTER when ready’.

6. Use the direction buttons to move the telescope to the home position (tube pointing south
and parallel to the floor). You may need to change the rate in order to move the scope in
a reasonable time frame. When the scope is in position, press ENTER.

7. The controller will now show: “POWER OFF”

“Turn power off when ready, do not move scope. UNDO to exit.”

9. Power down the telescope by turning off the rocker switch located on the left rear of the
telescope base.

91
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Other Notes:

213

The four directional buttons are for moving the telescope only, they will not scroll
through a menu. To scroll, use the UP and DOWN keys (6 and 9 on the keypad).

Pay attention when moving the scope with a “GOT0” command. There are slew limits set
so that neither the camera nor the tube will run into the base of the telescope. When a
limit will be breached by a GOTO slew, the hand controller will display a slew limit
warning and ask you whether to continue or cancel. If you are sure the telescope can
point where you want to go, have a lab instructor check your coordinates. ONLY a lab
instructor SHOULD OVERRIDE A SLEW LIMIT WARNING!!

In the event that you need to cancel a GOTO move while the scope is still moving, press
one of the direction buttons. The UNDO button will NOT stop the slew. Canceling a
move in this way does not seem to affect the alignment.

In order to change the driving speed, you need to use the RATE button. Rates go from 1
to 9 with 9 being the fastest. In general, 3 (4x sidereal rate) is a good speed for eyepiece
viewing, 7 (.5°/sec) for the finder, and 9 (3°/sec) for slewing. To change the rate, press
the RATE button followed by the number of your desired speed. The number will show
up briefly on the upper right of the hand controller screen.

A GOoTO move usually takes about 10 seconds to center up after the fast slewing. A bar
will rotate in the upper right corner of the hand controller screen until the scope has
stopped moving. Do not try to move the scope until this bar has disappeared.

Most commands need to be initiated from the top-level menu. To get there, press UNDO
as many times as necessary until the hand controller screen displays “NexStar GPS”.

Telescopes in Bays 3 & 4

These telescopes are both controlled by a Paramount ME™ mount. These were upgraded

from Celestron mounts to Paramount ME™ automated mounts in Summer 2007 and were
developed to enable data-taking for 12.410 from the astronomy lab (37-292). You will be using
TheSky6™ software (on the desktop in the Bay) to operate the telescope, and CCDSoft™ (Sect.
3.1) to operate the CCD (also on the desktop). Although these telescopes are automated, you
must still demonstrate your knowledge of how to operate the mount during your lab session,
recover from mount errors, and verify the telescope is indeed pointing where it should be. The

following instructions are imperative t

(0] ensure proper use:

=N e
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Figure 21. Telescopes in piers 3 and 4

Set-Up of the Telescopes and Computer

1. Turn the computer on (may need to turn power strip on) in the bay by pressing the
button on the back of the small Apple drive next to the monitor. The computer should
automatically start up Windows (If, for some reason, it starts up in Mac OS, restart the
computer holding down the “Option” key, and select Windows).

2. Turn on the power strip located on the pier, under the telescope mount. This will cause
the mount to start humming, and it should make two separate beeps. You will know that
the camera is on when you can hear its decently loud fan. The focuser will start counting
up to the last position it was set at. Do not connect to the camera until the focuser has
stopped counting.

3. On the computer, open up TheSky6™ ,located as a shortcut on the Desktop.

4. In order for the telescope to be correctly oriented, it must be put in Home position
before every observing run. This can be done by using TheSky6™ : go to the “Telescope”
menu item, scroll down to the “Link”, and select “Establish”. The software will link up
to the telescope, and ask you if you want to home the telescope. Select “yes”. You may
also home the telescope by pushing the button on top of the joystick twice, quickly, or by
selecting “Find Home” under the “Telescope” and “Options” menus.

Either use the software or the joystick to home the telescope, but do not use both
methods. If you get an error telling you that TheSky6™ is not connected to the computer
clock, make sure the icon telling it to do so is selected in the toolbar.

5. The telescope will begin to move into its “home” position. Make sure to keep any
restricting cords out of its way. You will know when the telescope has been homed when
you hear two separate sets of three beeps.

6. Now that the telescope has been homed, you can control it using TheSky6™ software
or the joystick. Use of the TheSky6™ software is in Sect. 2.3.

Turning off the Telescope and Computer

1. Put the telescope back in the “Park” position, (In TheSky6™ , go to “Telescope” =>
“Options” = “ Park”). You MUST park the telescope before shutting down. This
immobilizes the telescope (in case you forget to turn off the power strip, it will not keep
tracking and hit the roof) and helps put it in proper alignment for your next observing
run.

2. It is now safe to turn the power off. Do so on the power strip on the mount.

3. Shut down the computer.
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Important Notes

The telescope mounts have two positions: telescope on the east side with the
counterweight on the west side, and telescope on the west side with the counterweight on
the east side. The mount cannot track to a position where the telescope is below the
counterweight. Because of this, you cannot take a series of images of an object crossing
the meridian. If you do, the telescope will stop tracking, and the images of stars will look
like long lines. TheSky6™ will warn you of this by displaying your object going into a
pink “danger zone.” This is a buffer of about 10 minutes on either side of the transit time
(when the object will pass over the meridian). You can look up the transit time
beforehand in TheSky6™ . Once your object has passed into the “danger zone,” you can
re-slew to the object (the telescope mount should turn all the way around) and continue
taking images.

If you notice that the telescope pointing is off, do not attempt to sync it. A class
instructor can show you how to fix this without deleting the pointing model the mounts
build up.

2.2 Operating the Wallace 16” Telescope

The 16” telescope is located in the dome to the east of the shed. Its mount has recently

been rebuilt, and will now work with TheSky6™ (Sect. 2.3) for finding and tracking targets, and
CCDSoft™ (Sect. 3.1) for taking images.

Department of Earth, Atmospheric, and Planetary Sciences and Department of Physics
Massachusetts Institute of Technology

labManual.61.doc Page 29 of 111



Figure 22. 16-inch Telescope. The finderscope and guidescope are located above the main
telescope.

Setup

1. Open dome shutter by releasing rubber latch, and cranking opener.

Figure 23. Dome shutter. Open by releasing the rubber latch in the center, and cranking
the handle on the right.

2. Remove cover from telescope.

Remove covers from finderscope and guidescope (if needed) — it may be
easier to remove these covers later with the telescope pointed more towards
zenith.

4. Turn on the power bar on the right side of the desk.
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Dome Controls

10.

11.
12.
13.

14.

1.

. Turn on the Mac cube with the switch on back (under desk towards right.)

Turn on the TCS PC (under cube.)

Update the PC clock, if necessary, to the current UTC by right clicking on
time in the lower right hand corner of screen and selecting “Adjust
Date/Time.” Leave the time zone at (GMT) Casablanca and set current UTC
under time window (EDT+4, EST+5), verify the date is “tomorrow” if UTC is
after midnight (>12 am). Be sure to verify that the AM/PM option is correct.

. Start the TCS program by clicking the TCS icon. This is a DOS program with

runtime menus along the bottom of the screen.

Enable the serial port for TheSky6™ interface by using the arrow keys to

select the “pArameters” submenu.

e Press ENTER, then press ENTER again to select “Input”

e Select “Remote”

e Use the down arrow key to highlight “COM4” (which should already be
designated by “>>")

e Press ENTER twice, the “>>” will cycle off, then on (it will also cycle the
grey “TheSky6™  label- towards the lower right of the screen. This is a
sign that it is connected to TheSky6™ .)

e Press ECS three times to back out.

Turn on the power bar at the base of the RA axis (towards dome slit)

e This will power telescope controller (black box below RA drive), which,
in turn, powers the stepper drive motors and the STL1001 camera

e Caution: this power strip should never be on without TCS running.

Login to the Mac

Start TheSky6™ and CCDSoft™ .

In TheSky6™ , click the “Establish Link™ green telescope icon. You will know

that it is connected when “TheSky” starts to flash on and off in the TCS

program. You can now turn off the TCS monitor to reduce unnecessary light.

Set up CCDSoft™ as explained in Sect. 3.1.

Slew the telescope to the first target, or a nearby reference star using
TheSky6™ (you do not need to “home” the telescope first, unlike the setup in
shed telescopes 3 and 4). Note the altitude and azimuth values of the target
from the object dialog box.

Note: The telescope controller has three power settings: Variable, Slew, and Track. The
controller will normally be left in Variable, which should provide enough power for
slewing. If either stepper motor stalls (high pitched whine from either motor), use the F9
key (labeled Stop) to cancel the current move command, which will result in the drive
losing its position info. The telescope will then have to be resynched (see below) on a
celestial target. If the motor(s) continue to stall, get help.

2. Use the alt/az values to determine the initial dome slit position.
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3. Using the reference table to the left of the Mac keyboard, look up the dome
position index value (0-40.9) associated with the target alt/az coordinates.

4. Use the dome rotation buttons to move the dome position value (from the
reference table) over the index (blue arrow/pointer.) The dome motor control
buttons are located on the southwest corner of the pier near the red LED (the
red LED is on the dimmer that controls the brightness of the dome position
light.) The rotation controls consist of three buttons, the outer two start
rotation of the dome in the selected direction, while the middle (red) button
stops rotation (and must be used before reversing direction.)

Figure 24. Dome rotation markers. For the correct dome position, line up the bottom
arrow with the number given by the chart next to the computers.
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Figure 25. Dome rotation controls. The white slider will turn on a light that illuminates the
dome numbers. The black buttons on the grey controller move the dome, and the red
button stops the rotation.

Focusing

labManual.61.doc

. The initial dome position will be good for 10 minutes or so, but will have to

be updated regularly since the dome does not autotrack.

. Once you have set the dome position, take an image with CCDSoft™ to check

the pointing and focus. You will rarely need to adjust the focus, but will
almost always need to adjust the pointing. Follow the steps in the two sections
below to fix these issues.

. Under the CCDSoft™ Focus Tools tab, activate continuous focusing

exposures. (max. 1sec) Click on “Take Image” with the “Continuous” box
checked.

. Check to see how the focus of the images looks. Refocusing is rarely required

on this telescope.

. If focusing is necessary, turn the power on for the Blue DAEDAL controller

under the desk. This provides power to the old hand controller with small
focus pushbuttons near white guard at top (note- all other buttons/switches on
this paddle are disabled)
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DAEDAL INC

Figure 26. DAEDAL controller. This only needs to be turned on during focusing.

4. The pushbuttons move the focuser at one rate, so very short “pulse” inputs
will be required to achieve sharp focus.

Figure 27. Focus controller. The two buttons to the left in this picture will move the
focuser.
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5. Once focusing is complete, you can power down the DAEDAL if desired to
eliminate the cooling fan noise (you’ll have to turn it back on whenever re-
focusing is required, which should not be too often.)

Syncing Telescope

1. Once focusing is complete, use the pushbuttons on the larger black TCS
handpaddle to center the target in the FOV. In CCDSoft™ , you can zoom out
to see the whole image in one screen, and see where the center is by selecting
“Image” -> “Show Cross Hair” note: the center cursor “box” is 30 arcsec wide
on the STL 1001.

2. Use the GUIDE and DRIFT pushbuttons on the hand controller for small
(DRIFT) and very small (GUIDE) corrections. When centering on the cursor
box, the GUIDE rate should be adequate.

3. Once the object is centered, click on the object in TheSky6™ , go to the
“Telescope” tab of the object dialog box, and click “Sync.” This will
synchronize TCS and TheSky6™ .

4. You should repeat step 3 every time you move the telescope with the
handpaddle. You should resync the telescope as often as necessary.

Figure 28. TCS handpaddle. Use the directional buttons to move the telescope, and the
Guide/Drift/Slew buttons to adjust the rate.

Exiting

Unlink TheSky6™ and TCS (red telescope icon)

Disconnect camera (CCDSoft™ “Camera” -> “Setup” ->"Disconnect”)

Turn off DAEDAL focuser power, if on

In TCS, highlight “shutDown.” Press enter twice, and the telescope will slew

to park position.

5. Turn off power bar at base of RA axis: this will shut down the telescope
controller and camera.

PR =
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Press enter one more time in TCS to exit program.

Quit TheSky6™ and CCDSoft™ . Do not save any changes.

Transfer data

Shutdown TCS PC and Mac Cube, then power bar at the right edge of the
desk.

10. Replace cover on telescope and finders.

11. Rotate dome to park position (blue arrows/”’0” index)

12. Close shutter.

13. Turn off all lights and lock doors.

O 00 N

2.3 Using TheSky6™ Software for Telescopes 3 & 4

TheSky6™ 1is a software only compatible with Windows, and is therefore only on the

Macs that run Windows (the desktops located in Bays 3 & 4). It is used to control the movement
of the automated telescopes, and is very simple to use. The following are some basic commands,
but feel free to experiment with the program yourself.

1.
2.

3.

10.

Open TheSky6™ via the shortcut located on the desktop of the computer.

Follow the instructions in Sect. 2.1.3 in order to home the telescope if you are using one
of the telescopes in pier 3 or 4.

Right-click on the star chart, which creates the background of TheSky6™ . Go to “Find”
and type in your object of interest.

To access the database of extended minor planets, go to “Data,” “Extended Minor
Planets,” make sure the astorb file is selected, and click “Compute.”

. If your object is in the database of TheSky6™ , a window will pop up with information

about your object (such as current altitude, rising and setting times, coordinates). Before
moving the telescope to that object, make sure that the altitude is above 20 degrees.

. Click on the rightmost button at the bottom of the window, “Slew”. The program will

then verify that you want to slew to that object.

. The telescope will start to move. Be careful to keep yourself and other cords out of the

way. The automated mount may take a strange path to get to its destination, but do not
interfere with the telescope while it is moving.

. Your object of interest should be in the camera FOV, but you will need to center it via the

joystick. You can take exposures in CCDSoft™ following instructions in Sect. 3.1.

. In TheSky6™ , you may also input celestial coordinates if your specific object is not in the

database. Go to “Orientation,” “Move To,” and make sure the program is in equatorial
mode.

Be sure to Park the telescope by the instructions in Sect. 2.1.3 — Telescopes in Bays 3 & 4
before closing the program.

Now that you understand how to plan for observations and operate the telescopes and the
computer software, you are equipped to use this instrumentation to collect real astronomical data.
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2.4 Exercise

This exercise illustrates the relative difficulty of locating objects of different brightnesses
in the sky with our telescopes. It should also to give you an idea of what types of finder charts
that you will want to make for your own projects. The finder charts in Figure 29-Figure 32 are
not necessarily optimal, but should give you an idea of what to strive for. Two charts are
included for a few of the objects of interest, a “distant” finder chart to get yourself oriented in the
sky with respect to the constellations and a “close-up” finder chart so you know what you should
see in the finder, eyepiece or camera. Some of the telescopes have automatic control software,
but you need to have finder charts. The telescopes will point close to your object, but they are not
perfect and you need to be able to identify what you are looking at.

Choose a partner and locate the following objects in the sky with the telescope. Start by
locating the object in the finder scope (center it in the finder) then look in the main eyepiece and
center it with the fine controls. In your lab notebook draw a picture of what you see in the
finderscope and the eyepiece (see next page). Make notes for yourself about anything that
helped/hindered you in finding these objects or significant differences between the finder and
eyepiece (orientation, ease of seeing an object etc.)
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The Moon

Vega (V=0.0), Altair (V=0.75) or Deneb (V =1.25)
M31 (V=4)5)

Uranus (V =5.7)

M11, the Wild Duck open cluster (V = 7.0)

M57, the Ring Nebula (V=9.7)

NGC 6756, Open cluster (V=~11)

Also make some notes in your book about the conditions of the evening. Is the Moon up
(how full is it)? Is the Moon close to any of the objects you want to look at? Are there clouds?
Does the air seem still or is it turbulent? What time is it (beginning and end of observations)?
Where are you located? What telescope are you using and who is your partner? The more
information you can record about the conditions on a night you are collecting data, the more
information you don’t have to “just remember” when you are trying to figure out your data
analysis. If in doubt, write it down! Find as many of the objects listed as you can in the time
allotted for this evening and record your findings in your notebook or in the sample area below.

Finderscope Eyepiece
Object:
Date/Time:
Filter:
Comments:
Weather:
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Finderscope Eyepiece
Object:
Date/Time:
Filter:
Comments:
Weather:

()

Finderscope Eyepiece

Object:
Date/Time:
Filter:
Comments:
Weather:
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Altitude: 66° 0.452', Azimuth: 210" 2.046' (south west)

Figure 29. Sample finder chart for locating bright stars in the Summer Triangle: Vega,
Deneb and Altair. North is up, and East is to the left. This is a standard view, and all of the
finder charts here follow this convention. This finder chart has a large field of view, and
while Pluto will be below the horizon in early fall, the rest of this chart will extend to where
you can easily see it.
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Altitude: 377 38.681', Azimuth: 64° 48.364' (north east)

Figure 30. Sample finder chart for locating M31 (The Andromeda Galaxy) with field of

view overlays for the finderscope, and the eyepiece.
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Eyepiece

W

Figure 31. Sample wide-field finder Chart for the M11 (The Wild Duck Cluster). This
finder chart shows M11 scaled for you to see its position relative to several constellations
that you can see with your naked eye. It does not give sufficient detail to center M11 in the
CCD camera on any of the telescopes.
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Altitude: 38° 51.497', Azimuth: 202" 30.245" (south west)

Figure 32. Sample narrow-field finder Chart for the M11 (The Wild Duck Cluster). This
finder chart shows M11 scaled for you to see its position in the finder telescope (mounted
on the side of each large telescope) and for you to see its position within the eyepiece of the
telescope.
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3 Recording Astronomical Data

The most widely used detector for optical astronomy today is the "charge-coupled
device" or CCD for short. This is the same type of detector that is used in commercial digital
cameras. For our purposes, all you need to know about a CCD is that is has many individual light
detectors termed "pixels" that are arranged in a matrix format of rows and columns. After an
exposure on a patch of sky is complete, the data from a CCD (the individual signal from each
pixel) are read into a file of numbers, with each number corresponding to the signal from each
pixel.

Each pixel's signal is the digitized output of an amplifier, which is linearly related to the
number of photons detected by the pixel during its exposure of an image of the sky produced by
the telescope. The signal has four components. One component is proportional to the light from
whatever astronomical objects that were imaged on it by the telescope. A second component is
proportional to the background light from the night sky that was also imaged on the pixel by the
telescope. A third component is the "dark current," which is a signal caused by the thermal
agitation of the holes and electrons within the CCD that grows linearly with the exposure time,
and the fourth component is the zero point (or "bias" level) of the amplifier used to read out the
CCD. The workings of a CCD are described in the course reference books (e.g. Section 6.3 of
Astronomy Methods by Bradt and Chapter 6 of Electronic Imaging in Astronomy by McLean).
Also, CCDs will be discussed in the course lectures later in the term.

With this very brief background, we now turn to the practical procedures used to record
CCD data with the equipment that you will use at Wallace Observatory. You will gain a deeper
understanding of the reasons behind these procedures as the course proceeds.

3.1 Using the CCDSoft™ CCD control program

3.1.1 Setting up the Camera

To begin taking CCD data you need to start CCDSoft™ from the
Desktop.
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Figure 33. Taking an image while using CCDSoft™ . The screen is red because TheSky6™
night vision mode is being used. You can see the status bar showing the progress of the
exposure, the temperature regulation, and the maximum pixel count from the last image.
The Take Image tab of the Camera Control window is open, which is where you will find
the options you need to set before taking an image.

1. Go to “Camera” and “Setup.” A little window will pop up that looks similar to
that displayed in Figure 34:

o
"~ Camera Control E

Setup ITake Imagel Focus Toolsl Autoguide' Color | AutoSave'

Camera: |SBIG STL Large Format Cameras :J Settings... I ' Imager
7 " Autoguid
Filter Wheek: [SBIG Intemal STL CFw/ | Settings .| = O
Focuser: IDplec TCF-S :] Settings... |
Disconnect

IV Save images with coordinated universal time (UTC)

™ High priority downloads e
™ Screen shutter ile Defaults... I

[V Download aborted exposures exposed longer than (seconds): [E»Uj_:_l Temperature... |
IV Auto contrast

AR P - Event Pluglns...l
[T Enstle Fliptirror Nohe j |L‘ 13

Device Linked Status Temperature Shutter Filter Max
Imager _|No i
|Autoguider| No i

Figure 34. Camera control window in CCDSoft™ , Setup tab. When you start the camera
for the night you need to click connect and begin the temperature regulation.
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2. Once the camera is connected you need to start the cooler on the camera. In the
“Setup” tab, click Temperature. Set temperature regulation to on, and set it at —15
to —25 degrees C. The temperature should be set such that it can maintain a low
temperature while working at 70-80% of its cooling capacity.

3. Next click on the “Autosave” tab and check the box marked: “save as FITS
files”. Make a folder to save your night of images to, and make sure the save to
path goes to that folder. When you are ready to start saving images, check the box
labeled “Autosave On" so you will not forget to save the images.

3.1.2 Taking Images
Next click on the “Take Image” tab, Figure 35:

Setup Take Image l Focus Tools | Autoguide | Color | AutoSave |
Exposure Subframe Bin * |mager

Minutes: }U _,;] " On Size... " Autoguider
Seconds: 11.000 :]j Image Take Image
— Frame: |Light v

Delay (s): (0.00 - Reduction: m
Series of: H—ZI

Filter: ] ™ To new window

Device Linked Status Temperature Shutter Filter Max
Imager  |No
iAutoguideri Na

Figure 35. Camera control window in CCDSoft™ , Take Image tab. This tab allows you to
select your exposure time, the type of image you would like to collect and how you would
like to bin your images. It is also the tab you use to collect images by clicking the ‘“Take
Image” button. When an image is being taken, its progress will be shown in the “Status”
column, and you will have the option to click “Abort” to stop taking the image. The ‘“Max”
column will indicate the maximum count from your last image, so you can tell if it was
overexposed.

The “Image Frame” menu allows you to select a normal “Light” image or calibration
images, “Dark” and “Bias”. We’ll explain “Flat” sometime during the semester but we are not
going to worry about this calibration for our projects. For more information on these types of
calibration data, refer to Sect. 3.2.1 "Calibration data for the CCD." The “Image Reduction”
setting should be set to “None” for this class. The “Autodark” reduction should never be used for
this class, because your raw image will not be saved.
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The “series of” option allows you to take more than one image in a row without
having to click “Take Image” each time and is very useful for sequences of exposures. You can
set you exposure time in the “Minutes” and “Seconds” options.

You can select three different bin settings for your camera with the “Binning” button:
1x1, 2x2 and 3x3. Binning the image down from 1x1 will reduce exposure times but also will
reduce the image resolution and lower the saturation point for your exposure.

Once you have focused the telescope you can start taking actual image data. Choose your
exposure time and click “Take Image”. The CCD control box will tell you what is happening,
for example: “Exposing Light Frame (34%)” and you will see the minutes ticking down,
or “Downloading Image”. Make sure to turn off the computer monitor and any lights to
reduce the noise it will add to images. Once an image is completed, it will be displayed on your
screen. To the right of the status bar, you can check the number of counts in your star so that you
make sure you don’t saturate your data.

By moving the cursor over the images, you will be able to see the pixel count in the
bottom status bar. In general you want the signal from your object to be something between
10,000 and 20,000 counts, although this is very hard to get for faint objects so do what seems
reasonable. By increasing your exposure time you will get more counts in your object but you
will also get more counts on the sky. The inverse is true for decreased exposure time. An
oversaturated image will have pixel counts of over 65,535. Exposures should not exceed 60
seconds, or inaccuracies in the telescope tracing will cause trailed images of the stars.

Figure 36. Sample of CCDSoft™ Focus Tools window. @focus is running, displaying a
graph of its progress in the Focus Tools tab, and the images it takes in the image window.
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3.1.3 Focusing

The “Focus Tools” tab is used when you first set up with the CCD camera. You can
either use the @focus feature, or manually adjust the focus with the “In” and “Out” buttons. It
will take a series of images, and you can adjust the exposure time and delay.

When you select “@focus,” you can specify the kinds of jumps the focuser should
make, and the initial direction. If you pick the wrong direction, @focus will eventually turn
around. You will be able to see the images that it uses as a check to make sure it selects the
sharpest image. There will also be a graph in the Focus Tools tab of the sharpness for each focus.
If @focus brings the focuser all the way out or in, or if the final image does not look focused,
you can run @focus again, or determine the best focus by hand. You should keep track of how
the focus of your images looks throughout the night; you may need to refocus as the temperature
changes and your objects move.

Astronomical Image Data

The following are three types of astronomical image data that you might want to collect
for your class project. The first is the measurement of position, which is termed astrometry. The
second is the measurement of the integrated intensity within a broad band of wavelengths, which
is termed photometry. The third is the measurement of an object's spectrum. This measurement
is termed spectroscopy if one is concerned only with the identification of spectral absorption and
emission features. It is termed spectrophotometry if one is concerned with the absolute
measurement of intensity as a function of wavelength. Although all the data acquired in this
course will be with CCDs, the way in which the data are acquired and the calibration data need
to analyze them depends on which of the three types of measurements is being executed.

3.14 Astrometry

Astrometry is the measurement of the position of an astronomical object within a
standard reference frame. A common use of astrometric measurements is to derive orbits for
solar-system bodies. To perform astrometric measurements of fixed or moving objects, one
should obtain CCD frames that include not only the object of interest, but astrometric reference
stars as well. Astrometric reference stars—recorded on the same frame as one's object—serve to
calibrate the coordinate system.

3.1.5 Photometry

Photometry is the measurement of the brightness of a body within a broad band of
wavelengths. The wavelength bands most commonly used are defined by a set of filters; the B
("blue"), V ("visual," which appears green), R ("red"), and I ("infrared") filters comprise a
standard set. Absolute photometric measurements require calibration through observations of
standard stars (stars of known magnitude) during the same observing session when the objects of
interest are observed. However, one can make differential photometric measurements with just
one or two other stars acquired in the same field as your object of interest.
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3.1.6 Spectroscopy

Spectroscopy is the analysis of light by separating it out in wavelengths or colors. In this
class we will do spectroscopy in the visible wavelengths, about 400-800 nm. Spectroscopic
measurements require calibration with a known source; in this class we will use an argon lamp.

Spectrophotometry is a bit more complicated because you are interested in both particlar
wavelengths and the intensity of your object’s spectrum at those wavelengths. It is a quantitative
method of studying spectra. For this you need to calibrate both the wavelength (with the argon
lamp) and intensity (with a standard star) of your sources.

3.2 Calibration data

For each session in which you record data for your project targets at the telescope, you
should record calibration data as well. It is necessary to calibrate the CCD, the instrument, and
the Earth's atmosphere. Calibration data are essential for all astronomical measurements. The
type of calibration data that you need depends on the type of astronomical measurements that
you are making. The amount of calibration data that you need depends on the stability (over
time) of the instrument parameters and the stability of the extinction of starlight by the Earth's
atmosphere (e.g. perfectly steady clear conditions, or variable cirrus). Ideally, the calibration
data would be recorded before you record your target data, between exposures of target data, and
after you have finished recording target data. This ideal is not always achievable, since time at
the observatory is limited and the weather conditions are not under your control.

We discuss separately the calibration data needed for the CCD and the Earth's
atmosphere.

3.2.1 Calibration data for the CCD
For the CCD, three types of calibration data can be acquired:

Bias Frames. A bias frame calibrates the zero point, or baseline signal of the CCD
electronics. It is carried out by taking an exposure of 0.0 seconds while the camera shutter is
closed. If you look at a bias frame, it may contain irregularities such as cosmic ray events. These
defects may be eliminated in data analysis by taking several biases at the beginning of the night
and creating an average bias frame. Subtraction of a bias frame removes the average zero light,
zero exposure time signal from the data, including any "hot"-pixel effects (see Figure 37 for an
example of these).

Dark Frames. A dark exposure calibrates the rate at which the CCD pixels accumulate
signal when no light is incident on them, due to thermal effects. The cooler the CCD, the lower
the dark current. If you are using several different exposure times to for you project data, you
can calibrate the dark current vs. exposure time by taking a series of dark frames at exposure
times that span the range you are using. Keep the shutter closed for the dark frames. If you are
using just one or two exposure times, you can record dark frames at the exposure time you are
using as your light exposures; these frames will include the bias signal too. You should take a
few at the beginning, middle and end of the observing night.

Flat-field Frames. At some level any CCD chip will not be entirely uniform in response.
Certain pixels will be more sensitive to light than others. Also dust particles on optical elements
near the focal plane (such as the filter) will cause a non-uniform response. Thus, a target focused
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on a certain area of the field may output a different signal than the same target focused in another
area. A flat-field frame calibrates the relative sensitivity of each pixel in the CCD by exposing
the pixels to an extended light source of uniform brightness. The type of flat-field (dome flat, sky
flat, or rwilight flat) you take will depend on your project; you need flat-field frames in each
filter that you use for your project data on the night that you record the data.

If the zero point, dark rate, and sensitivity of all the pixels in the CCD did not change
with time, then only one set of calibration data would be needed for the entire term. However,
changes do occur, so more frequent recording of calibration data are needed.

CCDSoft™ makes the recording of calibration data easy. To record bias frames, change
the exposure type to “Bias” and the exposure time to O seconds. Take about 5 exposures (you
can use the “Take Series” button for this so you don’t have to click to start your image each
time). These will be saved in the data directory:

/Applications/Equinox 5.3/MPJjSBIG/MPjSBIGImages.

To record dark frames, change the exposure type to “Dark” and take 5 exposures for
each exposure time you used (again you can use the “Take Series” option). This is because
the dark measures the thermal noise accumulated in your CCD during your exposure. The dark
signal should be proportional to the exposure time. These images will be save in the directory:

/Applications/Equinox 5.3/MPjSBIG/MPJjSBIGDark.

Several procedures can be used for recording flat fields—one can use the twilight sky or
an evenly illuminated screen located near the telescope. If you are taking long exposures, or the
sky is bright with moonlight, you may be able to use the night sky for flat fields. Details of the
flat-field procedure that will be best for your project will be explained later by your lab
instructor. Be sure you remember to port the calibration files in addition to your data at the end
of the night.

3.2.2 Calibration data for the instrument

The only instrument that you may use in this course that needs calibration per se is the
spectrograph. The calibration needed is the wavelength scale for the pixels on the CCD, which is
carried out by exposing the spectrum of a gas lamp. Argon is a popular choice for the gas, since
it has a significant number of emission lines at visible wavelengths. Perform your wavelength
calibration early in the term, so that you can confirm that you are getting data within the intended
wavelength range.

3.2.3 Calibration data for the Earth's atmosphere

The Earth's atmosphere affects your CCD frames in two ways. One requires extra
calibration data, and the other does not. First, the atmosphere removes light from the direct
beam coming from astronomical objects by scattering and absorption—collectively these two
effects are termed extinction (see the course notes) and it varies with the wavelength of light.
Extinction effects can be removed from the data through calibration with observations of
photometric standard stars (non-variable stars with accurately known magnitudes). Several
observations of standard stars (at different altitudes above the horizon) are needed when
photometric and spectrophotometric data are recorded.
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Sometimes the technique of differential photometry is used. With differential
photometry, the standard stars are chosen to be in the same CCD frame as the object of interest.
Hence the standard star data are recorded whenever an object frame is recorded, and separate
standard-star observations are not necessary.

In addition to extinction, the Earth's atmosphere refracts (bends) the light from
astronomical objects by a small amount that depends on the altitude of the object above the
horizon. For an object at the zenith, the refraction is zero, but for an object 45° above the
horizon, the refraction is about 60 arc seconds (1 arc minute). Usually the calibration of
refraction is done with astrometric standard stars (stars with accurately known positions) on the
CCD frame with the object of interest, so astrometric measurements require no additional
calibration frames. Of course, one must be sure to have astrometric standards on the same
frames as one's object.

3.3 Checklist for Observing

Set up the telescope with TheSky6™ and point at a relatively bright star.

Bring up CCDSoft™ , connect the camera and begin cooling it.

Choose “save as fits” under the AutoSave tab

Choose “AutoSave On” under the AutoSave tab

Use the “Focus Tools” tab in CCDSoft™ to get your images focused for the star,

manually focusing the telescope

Move the telescope to the object you want to observe.

Start taking data and be sure to record notes about your data collection in your notebook;

a sample logsheet is provided at the end of this section.

8. Collect your calibration frames sometime during the night.

9. When you are finished collecting data, disconnect the camera and close CCDSoft™ .

10. Park the telescope using TheSky6.

11. Port the data to titania inside the main building at Wallace and your class locker on
Athena using SecureFX.

12. Choose shut down from the Start menu.

13. Turn off power strip on table and then on pier.

14. Put the cover back on the telescope.

SNH L=

~N

3.4 Data Collection

3.4.1 How to Choose an Exposure Time

When you plan your observations before going the observatory, a critical issue for your
plan is the appropriate exposure time. If your exposure time is too long, the image could become
saturated, making it impossible to use it for photometry. On the contrary, if your exposure time
is too short, you may not accumulate enough light from your source to have adequate signal-to-
noise ratio (SNR) to achieve your project objectives, especially for photometry and spectroscopy
projects.

Although the appropriate exposure time will largely depend on the magnitude of your
targets, but it can also depend on the observing conditions. If it is a perfectly clear, moonless
night, you will get a different amount of signal from a given object than if a full moon is present.
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A cloudy night with a setting quarter moon will yield yet a different background level.
Moonlight means more background light, you might want to increase your exposure time some.
Partial clouds or dew on the telescope optics will also result in less signal, so make the
appropriate adjustments as you go. Always be aware of what the environment is doing and
modify your observations accordingly. Choosing an exposure time is more of a method than a
standard, and it will vary for the same object from night to night, so BE FLEXIBLE with your
exposure time. You'll want to experiment each night before you collect data on your source.

That being said, these are some general "benchmarks" for exposure times if you are
taking images (photometry/astrometry):

* bright objects (brighter than 4th or 5th magnitude) -- 0.25 to 10 seconds
* middle-magnitude objects (6th-9th magnitude) -- 30 to 90 seconds
* faintish objects (10th-12th magnitude) -- 90 to 180 seconds

The tracking of the telescopes is good for about 3 minutes for point sources, although you
can try for 4-5 minutes. Don't go longer than ~5 minutes. Remember that the magnitudes of
fuzzy objects are for the integrated source (total magnitude over the whole area of object). For
most of these objects you will want to take 4-5 minute exposures. Exposure time will also be
filter-dependent — for instance, exposures in the B filter (or the number of images you take and
add together) should be at least 2 times longer/more than for V or R filter exposures for an
equivalent SNR.

The image quality or "seeing" also affects exposure time. We say that the seeing is good
when the atmosphere is stable and the images are small. A highly turbulent, unstable
atmosphere, produces larger images. For a given source, the image will contain the same amount
of light, so that the smaller the image, the larger the peak intensity at the center of the image will
be. With more light concentrated in the center, the image will reach saturation (see 3.4.2, Data
Saturation) sooner than on a night, perhaps requiring you to reduce exposure times if you are
near the saturation limit.

If you are doing spectroscopy you can't look at anything that is fainter than about 8th
magnitude. For fuzzy things (e.g. galaxies) don't go fainter than about 4th magnitude. Exposure
times will be approximately:

* Calibration frames (argon lamp): 30-60 seconds
* Bright source (moon, 1-3 mag object): 60-90 seconds
* Fainter sources (fainter than 3rd magnitude: 90-300 seconds

For spectroscopy projects, another easy way to make exposure time calculations is to
scale your target by the successful spectra of other similar objects (i.e. If your target is a star, you
could find the spectra and exposure time of another point source). If you have data for
successful spectra, you can determine your own target’s exposure time by scaling by a factor of
2.5 for every magnitude fainter that your target is to the reference’s spectra (Kannappan and
Fabricant, Sky & Telescope, July 2000).
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3.4.2 Data Saturation

Data saturation occurs when there is too much signal from the target, causing the signal
to reach a maximum limit, which is different from what the value of the signal would have been
in the absence of saturation. Hence saturated images are nearly useless for analysis.

Three types of saturation can occur: which type of saturation will be dominant depends on the
details of the electronics that process and digitizes the CCD signal. The first type of saturation
occurs when the number of electrons (produced by detected photons) exceeds the "full well" of a
pixel. The full well is measured in electrons. If the full well is exceeded, the pixel "bleeds"
electrons into surrounding pixels up and down its columns, creating streaks along the columns.
The second type, saturation of an electronic amplifier in the signal processing chain, may occur
first. The symptom of this type of saturation is several pixels at the same number—say 10233 —
and no pixels with a greater number. The third type of saturation is digital. The diagnostic of
digital saturation is having pixels with a signal of 2" — 1, where n is the number of bits used by
the analog-to-digital converter in the CCD electronics. Common values for n are 16 bits and 14
bits, for which you will see a lot of pixel signals equal to 65,535 and 16,383, respectively, if
digital saturation is occurring.

Although you can detect cases of severe saturation by looking at the image, it is difficult to
detect cases of mild saturation in this manner. Rather, there is a method to check for saturation
by examining the numerical values of the pixels. Use the "Display" tab in EquinoX and hover
over the image with your mouse where you want to check the values. You want about 30,000
counts (10-20,000 is okay too for fainter sources, saturation is 65,535 counts, assuming binning
of 1x1) on your target.

3.4.3 Checklists for specific project types

Astrometry Checklist

1. Choose your target.

2. Create a finder chart and locate the object with your telescope. Make sure there is more

than one other star in the field with your object (or the parent planet if you are look at a

satellite).

Focus.

4. Determine the exposure time to get well exposed images of the stars you want. If you
click on the display tab and look at the values, you will find out how much signal you are
getting for any given exposure time.

5. Take 5-10 images on your object and save them. Make sure you have clicked the “save as
fits” button so you get them in the correct format.

6. Itis critical that you record the start time and exposure time in your log book (as a check
on the values in the header). From these you can derive the mid-time of the exposure,
which will be used in your astrometric analyses later.

7. Do this every 20 minutes for a few hours, and on two-three nights, preferably over a few
days or weeks. The time interval will vary depending on what type of object you are
measuring. Use the “R” filter for your images.

8. Take bias and dark CCD calibration data.

W
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Photometry Checklist

1.
2.

W

Choose your target.

Create a finder chart and locate the object with your telescope. Make sure there is at least
one other star (two is preferable) in the field with your object.

Focus.

Determine the exposure time necessary to collect the information you want (see 3.6.1 -
How to Choose an Exposure Time).

Take 5 images on your object and save them. Make sure you have clicked the “save as
fits” button so you get them in the correct format.

Take sets of images constantly for 2-3 hours (or longer on an asteroid if you have the
time), you might want to switch back and forth between “V” filter and “R” filters taking
5 images in each every time.

Take bias and dark CCD calibration data.

Take standard star data a few times through the night (at least twice, preferably more
often, depending on the sky conditions).

Spectroscopy Checklist

1.
2.

Choose your target.

Create a finder chart and locate the object with your telescope. You need to put your
object in the centre of the black circle in the eyepiece (when it is there you will not see
any light from the object by eye.

Determine how long a picture you need to take to collect the information you want (see
3.6.1 - How to Choose an Exposure Time). If you click on the display tab and look at the
values you will find out how much signal you are getting for any given exposure time.
Take 5-10 spectra on your object and save them. Make sure you have clicked the “save as
fits” button so you get them in the correct format.

Take bias and dark CCD calibration data.

Take argon lamp calibration data a few times through the night (at least at the beginning
and end of your observations).
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3.5 Assessing Your Raw Data at the Telescope

It is important to assess your data after taking your first few exposures of the night, so
that you can catch any subtle problems early on. Many students have wasted a good night of
observing because they did not check for or were not aware of certain issues, and end up with
unusable data. Some common problems are (i) out-of-focus images, (ii) cloud cover, (iii)
trailing, and (iv) saturation.

3.5.1 Focusing the CCD

It is imperative to focus the CCD before taking data. Poor focusing unnecessarily
degrade the resolution of your data, making them less sensitive to faint objects because of the
smearing. The focus can be so poor that the data are unusable, depending on the brightness of
the object and the density of stars in the field. The following is an example of unfocused and
focused data, both before and after calibration. This should help you to recognize the signs of
poorly focused data and how to correct them before it’s too late.

Unfocused Images:

Figure 37 Unfocused image before calibration. The doughnut-like appearance of the three
comparison stars are a strong indication that the CCD needs to be focused. This does not mean
that you can simply look through the eyepiece and turn the focus knob on the telescope until it
seems in focus. Rather, you must focus the CCD using images that you examine displayed on
the computer.
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Figure 38. Unfocused image after calibration. By subtracting an average bias frame, the hot
pixels (defined below) are now eliminated, revealing much fainter stars. Although the
comparison stars now seem in focus, the doughnut-like appearance of these fainter stars are
strong indicators that the image was not in focus when it was taken. This image can still be used
for photometry and astrometry of the brighter, isolated stars, but not for stars that are close
together. For example, the boxed stars are nearly blended together, disallowing them to be used
for differential photometry or astrometry. Images of Delta Scuti and 3 comparison stars, taken
with Telescope 4 on July 25,2007 at 05:16 UT

Now that we have seen an example of an unfocused image, before and after calibration,
let’s look at focused images, and what you should be aiming for while taking data.

Well-focused Images

Figure 39. Focused image before calibration. This image was taken after focusing the CCD.
You can tell that the image is well-focused because the target and three comparison stars now all
appear as sharp images rather than doughnuts. The fainter blemishes are more distant stars,
while the white speckles are again, hot pixels, and will be removed upon calibration. If you look
closely enough, you will be able to see the same hot pixel patterns in this image with the
uncalibrated image on the previous page.
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Figure 40. Focused image after calibration. Among other things, calibration removes hot
pixels. You can verify that this image is well-focused by the crisp appearance of all point
sources in this frame. The two fainter stars which were previously almost blended together are
now well defined. These two stars, along with every comparison star in the frame, may now be
used for astrometry or differential photometry. Images of Delta Scuti and 3 comparison stars,
taken with Telescope 4 on July 25,2007 at 05:16 UT.

As you can see, focusing the CCD is extremely beneficial to data analysis. A well-
focused image such as the one above is a more accurate representation of the sky than an
unfocused image. Thus, if your analysis yields results which you do not expect, you at least
know that it cannot be attributed to poor focus.

Tip: It is a good idea to focus the CCD multiple times during the night because the
temperature of the telescope changes, which will cause it to change focus. Consequently, objects
can go out of focus very easily.

3.5.2 Hot Pixels

Hot pixels are disfunctional pixels on the CCD that have very large signal values. The
white speckles in the uncalibrated image above were identified as hot pixels because of their
consistent pattern from image to image, and their high values (significantly higher than the
normal pixel value). Generally, hot pixels may be ignored during observation provided that you
take enough calibration images for their removal, but you should recognize them while
observing.

3.5.3 Cloud Cover — When is it too much?

Suppose you arrive to the observatory and it’s a relatively clear night, with only a few
wispy clouds in the sky. The clear sky clock tells you that it’s supposed to become increasingly
cloudier later in the night, although for now, the cloud cover does not seem thick enough to
affect data-taking. But when will it become too cloudy? When the cloud cover is gradually
increasing like this, it is difficult to say. As you will see, it is often necessary to take as many
images as you can and then calibrate the data back in the lab in order to see how greatly the data
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were affected by clouds. Generally speaking, thick clouds will affect the data regardless,
whereas the effects of thin clouds or minimal atmospheric moisture are much less. The
following are two examples of uncalibrated images taken twenty minutes apart on a night like
the one described above.

Not too much cloud cover:

R Calibrate

—

Figure 41. Image of Delta Scuti before and after calibration with minimal cloud cover. Data
taken on Jul. 25,2007 at 04:04 UT, through some wispy clouds. The uncalibrated image does not
seem too affected. Although dimmer, most of the stars are seen. After calibration, the image
looks very clear. The appearance of fainter stars indicate that cloud cover was not too thick.

Too much cloud cover:

Figure 42. Image of Delta Scuti before and after calibration with too much cloud cover. Data
taken on Jul. 25,2007 at 04:24 UT, through more significant cloud cover. However, after
calibration, the image shows a high noise level, indicating that significantly less starlight reached
the detector than without the clouds. This is the effect of significant cloud cover, considerably
reducing the signal levels from the stars relative to the noise. Analyses of these data will yield
less useful results than frames recorded when clouds are absent.

As you can see, cloud cover is constantly changing - as quickly as the clouds come, they
may go, too. Consequently, vastly different images can be taken even 20 minutes apart.
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However, never completely give up on observing if the cloud cover is minimal. As seen above,
you could still end up with acceptable data. Note that you may get away with significant cloud
cover if you are doing differential photometry, since cloud thickness should not vary much
within one frame. As long as you are getting good images of your object and comparison star,
the data will be useful.

3.54 Trailing Images

Trailing is the severe elongation of a target as it appears on an exposure. Although this
may occur for long exposures because of imprecise telescope tracking rates, shorter exposures
(60 seconds or less) should not have any trailing. Trailing usually occurs when the telescope has
had some sort of tracking error, or the telescope is knocked, causing it to shift out of place,
creating streak marks.

Trailing is very easy to identify, but not often easy to correct. If there was trailing
because you accidentally knocked the telescope during an single exposure, you simply need to
readjust the telescope to center the target, and continue taking data. If there was trailing due to
an intrinsic tracking problem of the telescope (identified by continual trailing over several short
time exposures), there could be any number of problems, including weight imbalance, or
telescope alignment. This kind of trailing is more severe, but can be easily fixed if you act
quickly.

Tips: Take a few single test exposures at the beginning of each observing run before
taking your calibration images to make sure there are no intrinsic problems with the telescope. If
there are any, notify your TA. Also, do not touch anything when the CCD is exposing - the
telescope is very sensitive to any slight pressure on it.

Here are two examples of trailing for different reasons:

Figure 43. Data taken on Sep. 28,2006 at 02:25 UT. Asteroid Iris and a comparison star.
Trailing due to bumping of the telescope while it was taking an exposure, on Telescope 2 (an
automated GO-TO telescope), producing double images.
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Figure 44. Data taken on Jul. 24, 2007 at 03:39 UT. Dwarf cepheid Delta Scuti and a few
comparison stars. Long trails due to improper sidereal tracking rate. It was found later that there
wasn’t enough counterweight on the barrel of the telescope to allow correct for tracking. Grainy
background is mainly due to significant cloud cover.

3.6 Data validation

Once you have recorded data, you want to be sure that your files actually contain the
data, and that the data are what they should be. Your first test is to make sure that the signal you
are recording in the images is what you expect (use the information in CCDSoft™ to check the
counts in your images.) Additional procedures for validating your data are described below.

Before continuing with observations, take a few test images of your object and go
through the corresponding data validation checklist. It is extremely important to go through this
checklist, or the data you collect may be considered “bad data.” Consequently, the night of
observing will be wasted.

3.6.1 Astrometry/Photometry Data Validation

1. Compare your finder charts with the view in the finderscope and camera. Although the
view in the finderscope and camera may appear inverted or rotated due to the mirrors in
the telescope, they should still completely correspond with your finder charts.

2. Focus the image using your target or a star in the same CCD frame. Your star profile
should have a defined peak.

3. Check for saturation by looking at the “Max” column in the Take Image tab and reading
the number of counts, or by moving the mouse over an image and reading the counts
displayed in the bottom toolbar. With this number of counts, use the following table to
assess whether the exposure time is reasonable. If not, adjust the exposure time
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accordingly. A longer exposure time will give you more overall counts (in both your
target and background).

4. Ensure that there is minimal trailing in your images. If there is, your telescope may have
tracking or weight balance problems. Alternatively, try to focus or adjust the exposure
time until objects appear as point sources (or as close as possible) without saturating the
image. See Section 3.4.2 for more details.

3.6.2 Spectroscopy Data Validation

1. Make sure the light that comes through is penetrating the correct part of the fibers.
2. Compare successive images. Are there any outstanding features in one image but not the
other? This may be a blemish and that image cannot be used in data analysis.
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3.7 Log sheet

Date:
OBSERVER(S): WEATHER:
TELESCOPE: 1 2 3 4 Focus:
PROJECT:
FILE NAME OBJECT TIME EXPOSURE | FILTER | NOTES
TIME
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4 Porting Data

4.1 To the observatory data archive computer (titania)

In order to access your data from campus, you need to put it onto a computer that is
always running and has a network connection to campus. This machine is our Wallace server
called “TITANIA”. It resides on the rear computer table inside the main building at Wallace and
is accessible via a secure connection from any Athena computer on campus. The shed computers
are always turned off when we close up the shed so anything left on these machines are only
accessible to you during your lab section. To transfer data from machines running Mac OSX do
the following. For Windows XP machines such as those controlling the Paramount MEs, see the
next section.

1. Select “Go” from the menus at the top of your shed computer. Type
titania.mit.edu at the prompt, or select it from the list of saved computers

: (F
Cor I lg
ur
titania.mit.edu E ‘ e
| 45
astron.mit.edu )

occult.mit.edu
phoebe.mit.edu
titania.mit.edu

magellan-telescopes.mit.edu J ‘

> v o v \»

Figure 45. Sample of the window for connecting to a server with MacOSX. See text for
step-by-step connection instructions.

2. Type in the user name: students
and password (ask your lab instructor if you don’t know it)
select the "Data” volume to mount.
4. Change to the directory:
/Volumes/Data/Classes/12.410-2008/
5. Create a folder with your Athena login in which to store your data:
/Volumes/Data/Classes/12.410-2008/username/

6. Find the folder on your machine that contains your data from the night and move

your calibration files into your image file directory.

7. Select these and drag them into your image folder on titania.

8. Drag your folder from the images directory on your shed computer to your
directory. Be sure you have copied both your image data and your dark and bias
calibration data (which after the previous step should all be in the folder titled by your
date of observation).

W
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4.1.1 Data transfers with SecureFX

To transfer data from computers running Windows XP (all Piers and 16-inch during 2008),
open SecureFX from the Desktop icon. Find your folder in titania as described above, and drag
your files from the night into that folder. Close the SecureFX window to log out.
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4.2 To the class Athena locker: Secure File Transfer Protocol (sftp, scp)

Now that you have transferred your data to the disk TITANIA, you can access it from
campus. Data on TITANIA should remain there until the end of the term, barring any
unforeseen problems. However, your primary data storage should be your Athena account, so
you should transfer it there at your earliest opportunity (before leaving Wallace for the night is
recommended, if time permits). This way you will be all set to reduce your data the next time
you go to work on your project. In addition to your computer in the shed, the data transfer can
be done from the computers inside the main Wallace building, or any Athena machine (as
described in the file transfer section of chapter 5).

4.2.1 Data transfers with sftp

Go to the dock (bottom of the screen) and click in the “x11” icon. This will open an x-
term window on your computer. Change directories to the location of your images on your local
(shed) machine.

On a shed computer:
[WAOl:~] wallace% cd /Applications/Equinox 5.3/MPjSBIG/MPJSBIGImages

On titania:
[TITANIA:~] titania% cd /Volumes/Data/Classes/12.410 2008/username/

Connect to Athena with sftp:

[TITANIA:~/Public/username] titania% sftp username@athena.dialup.mit.edu
Connecting to athena.dialup.mit.edu...
username@athena.dialup.mit.edu's password:

Type in your password. Once you are logged in, change the directory on Athena so you are
located where you want to put your data:

sftp> cd /mit/username/12.410-data/

Check that you ended up where you wanted to be:

sftp> pwd
Remote working directory:
/afs/athena.mit.edu/user/u/s/username/12.410-data

(Change the “u/s/username” in the above line to your appropriate destination, such as “j/r/jruser”
for the username jruser, or “other/username” if one of the first two characters of your username
is not a letter.) If you want to create a new folder here you can do so with the mkdir command
then cd into your new directory.

sftp> mkdir 2008-09-22
sftp> cd 2008-09-22

Put (all) your images onto Athena; here the “*” is used as a "wildcard," which matches any
group of characters:
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sftp>put *
Light NXXX B1+0C_30S0-1l.fits 100% 640KB 43.8KB/s 00:13

For example, if you just wanted to put only some of your images in your Athena locker—say all
the files whose names begin with "Light" and end with ". £its" (with any group of characters in
between), you would type:

sftp>put Light*.fits
Once your data are all there, type “bye” to leave sftp:

sftp>bye

4.2.2 Data transfers with scp

As an alternative to sftp, you can use another command called scp, with which you can carry
out the data transfer in a single command line. On Athena make sure you are in your 12.410-
data directory (/mit/username/12.410-data).

athena% scp -r titania@titania.mit.edu:/Volumes/data/Classes/
12.410_2008/username/ .

(type in your password at the prompt)

-r means “recursive” and will copy all the folders in the stated directory to where you are on
Athena. Make sure you have the ‘.’ at the end, this where you are copying your data to, in this
case your 12.410-data directory. If you are not in your data directory you can execute the above
command in a slightly different manner (all on one line) to get the same result:

athena% scp -r
titania@titania.mit.edu:/Volumes/data/Classes/Data/12.410 2008/usernam
e/ /mit/username/12.410-data/

Additional Notes:

Most normal xterm commands (cd, pwd, 1s, mkdir etc.) work in sftp and refer to
changes on the computer to which you are connected. If you need to change locations or get
information for files on your local machine while using sftp, put a “!” before the command (for
example, !pwd). The only command that does not use the “!” is cd, for this command you use
“led” (local change directory).

4.2.3 At Wallace: from the shed computer directly to your Athena locker

Before getting back to campus, you may wish to transfer your data from a shed computer directly
to your Athena locker, so you do not have to worry about transporting it later. This is very
useful to do at the end of an observing night, especially if you are waiting for others to finish,
because it will save time for later. To do so:

1. On a shed computer, open a terminal window. Type: “ssh username@athena.dialup.mit.edu”
or “ssh username@linux.mit.edu”, where “username” is your Athena Kerberos name. It will
prompt you for your Athena password.

2. Create a folder on your Athena locker by typing: “mkdir 12.410-data”.
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3. Open a second terminal window on the shed computer. Locate the files you want to copy by
navigating through the folders (“cd foldername” takes you to that folder). Navigate to the folder
which contains all of the files you want to transfer to Athena.

4. In this second terminal window, type: “scp * username@athena.dialup.mit.edu:.” It will
prompt you for a password to your Athena account. The * is a wildcard character standing for
any combination of any characters. Thus the command in the previous sentence will copy every
file in that folder into your Athena locker. You should see the transfer start to occur in the
terminal window.

5. Once the transfer is completed (which may take awhile if you have many files), you may view
your files in your Athena locker by going to the first terminal window and typing, “Is”. This lists
the files in your Athena locker. You may move them to the folder you created in step 1 by
typing “mv filename 12.410-data”.
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5 Computational Tools for Data Reduction and Analysis

5.1 Operating Systems

This tutorial will give you the bare minimum you need to get started in this class. General
UNIX commands are introduced, and all the examples given pertain to either working with your
project data or with files for a problem set later in the class. Documentation for the basic Athena
shell commands such as c¢d, 1ls, more, etc. are found using the man command. This
command (e.g. “man cd”) will bring up a description of the command and any options
available for use with the command. Further descriptions of this command are described in the
section below entitled: “The UNIX manual”.

5.1.1 UNIX and Linux at MIT

On the MIT campus, Athena is our server, a UNIX system. UNIX is a suite of programs
that form the foundation of our computer network for workstations and multi-user servers. On
Athena, X-terminals provide a graphical interface between the user and UNIX. The UNIX
operating system is made up of three parts; the kernel, the shell and the programs.

The kernel of UNIX is the center of the operating system: it allocates time and memory to
programs and handles file storage and communications in response to system calls. The shell is
the interface between the user and the kernel and is started when you log into the computer. The
shell is a command line interpreter. It interprets the commands that you, the user, type and
arranges them so the computer can carry them out. The commands are themselves programs:
when they terminate, the shell gives the user another prompt (% on Athena). Finally, everything
in UNIX is either a file or a process. A process is an executing program identified by a unique
process identifier. A file is a collection of data. You create files whenever you run a text editor,
compile code, save an image, etc. These files are stored in directories.

5.1.2 Athena

Log in to Athena

Ask a lab instructor if you are unsure how to do this.

Attach the course locker:

The 12.410 "locker" is a collection of directories mounted under the basic directory name
/mit/12.410. In order to work with files in this directory, you need to add the 12.410 locker
to your path. In any xterm or terminal window of your Athena screen, type the add command to
add the course file locker to your computer.

athena% add 12.410

(Use add here instead of attach because you want software that is in the 12.410 locker to be
accessible in your path.)
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Changing directories on Athena

Next, to change from your home directory to the class directory, you need to use the “cd”
command:

athena% cd /mit/12.410

Now you can change your working directory to the student subdirectory in one of two ways.
(1) with the cd command: you can specify a full "pathname", the entire directory path starting at
the first slash (/mit/12.410/student), or (2) since you are in the directory just above student
you can just type in “student” to move into that directory.

athena% cd student
In this case it is equivalent to:
athena% cd /mit/12.410/student

If you are in the student directory and want to move to the directory above you can use the
command:

athena% cd ..

where the “..” refers to the parent directory of the current working directory. Note that “.” refers
to your current working directory, and “/” refers to the "root", i.e. the top of the directory
structure in a UNIX file system. These shorter forms allow you to move between directories in a
relative fashion. For example, if you are in “Public” and want to go to the examples directory in
the “student” subdirectory, you would type:

athena% cd ../student/examples
In any location, you can list the files and subdirectories within that directory with “1s”:

athena% 1ls
12.411 Public idl_libs software www
OldFiles arch ops student

12.410 set-up script on Athena (RUN THIS ONLY ONCE!)

Now that you understand a little about changing your working directory in UNIX, you
need to set up some directories for your work in this class. To do this you will to run a special
script on Athena. This should only be run ONCE!

athena% setup 12.410

This script will do the following:
1. Create a 12.410-data directory in your home directory in which to store your data.
2. Give 12.410-staff permission to read and write in that directory.
3. Make a link to that directory in the /mit/12.410/student directory.

The net result is that you can cd into: /mit/12.410/student/username, and put all
of your data there. Then you can carry out your reduction and analysis work there as if it were in
the course locker, but everything will actually be stored in your Athena home directory data
space.

Now that you have set this up, make a new directory called “Tutorial” in your student
directory for the class with the command “mkdir”.
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Change your working directory to the one that you just created:

athena% cd /mit/12.410/student/username
athena% mkdir Tutorial
athena% cd Tutorial

You can check where you are by using the pwd (print working directory) command, however,
you should be aware that /mit is generically an alias for a variety of remote file paths, so if you
have done everything correctly you should get something like the following, except for your user
path.

athena% pwd
/afs/athena.mit.edu/user/s/u/susank/12.410-data/Tutorial

In normal use, you can substitute "/mit" for "/afs/athena.mit.edu/course/12"
anywhere you encounter it for this class (that is, if you remembered to attach the course locker as
described above).

The UNIX manual

If you want a complete definition of any command in UNIX, you can use the man command. Its
argument is the UNIX command that you want defined. Examples for cd and 1s are:

athena% man cd
User Commands cd(1l)

NAME
cd, chdir, pushd, popd, dirs - change working directory

SYNOPSIS
/usr/bin/cd [ directory ]

sh
cd [ argument ]
chdir [ argument ]
csh
cd [ dir ]
chdir [ dir ]
pushd [+n | dir ]
popd [ +n ]
dirs [ -1 ]
ksh
cd [ arg ]

cd old new

/usr/bin/cd

The cd utility will change the working directory of the
current shell execution environment. When invoked with no
operands, and the HOME environment variable is set to a
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non-empty value, the directory named in the HOME environment
variable will become the new working directory.

sh

The Bourne shell built-in cd changes the current directory
to argument. The shell parameter HOME is the default argu-
ment. The shell parameter CDPATH defines the search path for
the directory containing argument. Alternative directory
names are separated by a colon (:). The default path is
<null> (specifying the current directory). Note: The
current directory is specified by a null path name, which
can appear immediately after the equal sign or between the
colon delimiters anywhere else in the path list. If argument

~ 1 ~ 1

begins with /', ~.', or ~.. ', the search path is not used.
Otherwise, each directory in the path is searched for argu-
ment. cd must have execute (search) permission in argument.
Because a new process is created to execute each command, cd
would be ineffective if it were written as a normal command;
therefore, it is recognized by and is internal to the shell.
(See pwd(1l), sh(l), and chdir(2)).

To find the full definition of the command:
athena% man 1s
You can even find out more about the man command itself:

athena% man man

File Transfer

Only “secure” file transfer connections are allowed to Athena and to most other
computers as well. File transfer protocols will be needed to move the data you collect at the
telescope from Wallace to your directories on Athena for analysis. File transfers from the data
computers (which are Macintosh computers) to Athena will be handled via secure sftp with the
Macintosh command line interface, described previously in the section: To the class Athena
locker: Secure File Transfer Protocol (SFTP) and at the web location:

http://web.mit.edu/is/help/ftp/

For this tutorial, you will simply copy sample files from the examples directory to your personal
directory using the cp command.

athena% cp /mit/12.410/student/examples/UT20021021/* ./

In the above command, the “*” is a common ‘wildcard’ that means “match any set of
characters.” In the current context, it is a way of specifying the names of all files and
subdirctories in the given location ”*.fits” would specify all files ending in ".fits" The
“./’ (or simply a “.”) refers to the current working directory, so the cp command copies all files
from the UT941004 directory into the current directory which should be your Tutorial directory.

Check the results of your copy with the 1s command.

athena% 1ls
ps5-01.fits ps5-03.fits ps5-05.fits ps5-07.fits ps5-09.fits
ps5-02.fits ps5-04.fits ps5-06.fits ps5-08.fits
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If everything went correctly, you should see the listing above.

5.1.3 Macintosh

The layout and components of files on machines running MacOSX are called the file
system and often referred to as the “finder”. It consists of a series of files and folders and you can
invoke a terminal window or an X Window that recognizes the same commands as one uses on
UNIX (cd, pwd, etc.). The top level of the files system is called the “root” directory and can
be referred to with a “/” (as described above). Other directories are branched from the root like a
tree. User information and files are stored in /Users. /Systemis for various system files used
by the GUI, and all MacOSX applications, and user programs are stored in /Applications.

MacOSX also has a convenient windowing interface such that you can launch a program
by clicking on its icon in the “dock™ located on the bottom of your screen. Programs that don’t
have “shortcuts” or links to the application file can be found in the /Applications directory
and launched by clicking on the appropriate icon in the appropriate folder. You’ll learn a bit
more about specific programs throughout this manual.

514 Windows

Windows is an operating system with which you may already be familiar. It has a similar
interface and functionality to MacOSX as discussed above, but it is not based on the UNIX
operating system.

5.2 Creating Text Files

During several phases of data reduction, you will need to make and edit "text files" in
order to provide the computer with information it needs to continue your processing. A text file
is just that: a file with nothing in it but normal letters, numbers and other standard typewriter
characters (and the spaces between them). The data files you just transferred are binary files and
contain special characters that do not appear on a keyboard.

The simplest way to deal with text files on Athena is to use emacs. To open an emacs
window, use the command emacs as follows. (The & in the following command essentially tells
the current window to stay active and not transfer its control to the new emacs window.)

athena% emacs &

When the new window comes up, you can click in it, and type in it. Anything you type
there will stay in that emacs "buffer" until you quit the program, but it will then vanish. To save
it as a file (a textfile, no less), type Ctrl-x Ctrl-w (C-x indicates control-x and is typed
by holding down the "ctrl" key and typing “x” while it's down). It will then prompt you for a
file name down near the bottom of the emacs window. Type in a name for your file. You can
quit emacs by typing: Ctrl-x Ctrl-c. To see what is stored in your new text file use the
more command.

athena% more filename
If you wish to later edit the file, simply open it again in emacs.

athena% emacs filename &
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Make whatever changes you need to make and type Ctrl-x Ctrl-s to save your changes, then
Ctrl-x Ctrl-c to quit again.

For in-depth tutorials on basic computing skills and access to more help information than is
presented here, the teaching staff encourages you to examine Athena On-Line Help (OLH). This
web page contains pointers to numerous references and locations of additional sources of help. It
is located at the URL:

http://web.mit.edu/olh/

5.3 Environments

There are a number of environments that might be used for analyzing your project data
including IDL, Mathematica, MatLab, and IRAF'. The class software has been written in /DL and
is described in detail below. The other environments are introduced so you can be aware of what
various astronomers may use, however, further instructions are not provided in the manual. If
you already are familiar with the environment, you are welcome to work in it. The teaching staff
can answer basic questions; however, the teaching staff does not support instruction for new
users.

5.3.1 Interactive Data Language (IDL)

Getting Started

Interactive Data Language (IDL) developed by Research Systems Inc., or RSI, is a
commercial software package that requires a license for use. It will be used for most of the
image processing and data reduction we do in this class. This document explains how to access
IDL from any Athena (Sun) workstation and outlines the basic commands to be used in /IDL.
This short tutorial only scratches the surface of the capabilities of IDL, but will give you enough
background to run the tasks for this class. /DL is kept in a separate Athena locker called envi.

Commands in IDL

To use a UNIX command from within /DL, put a “s” before the command. Hence to list the
files in your working directory, you type:

IDL> $1s

The $ tells the computer that the command is to be run outside of the /DL interface. The only
UNIX command that works the same inside and outside of /DL is “pwd” — print working
directory.

In IDL single quotes are used to denote strings. The name of a directory is a string, which is
enclosed within two single quotes. The change directory /DL command is cd, and it is separated
from its argument (as are all /DL commands) with a comma:

To change directory type:
IDL> cd, ‘newdirectoryname’

If you do not know the path name of the directory to which you wish to change, you can get a
dialog box to search for the directory in a dialog window with the command:
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IDL> cd, dialog_pickfile(/dir)

Command Line editing

arrow keys moves the cursor as you expect

Ctrl-e moves the cursor to the end of the line

Ctrl-a moves the cursor to the beginning of the line

Ctrl-k deletes the rest of the line

Backspace deletes the character behind the cursor

Ctrl-s prevents the cursor from responding to keystrokes

Ctrl-q returns the cursor to normal function if you accidentally hit Ctrl-s

Getting out of an IDL procedure if it gets stuck or you make a mistake

ctrl-c will essentially kill the process you are running, however, after using Ctrl-c you want
to make sure IDL is not stuck in the middle of a procedure. You do this by resetting /DL to the
main level:

IDL> retall

This means "return all". Whenever things look weird in IDL, type retall.
If things completely hang up you can do a hard reset of /DL without exiting by typing:

IDL> .reset

Help menu
If you want to know more about a command or want to see if a command exists to do something
type a question mark at the prompt.

IDL> ?

This will bring up an interactive help window (run through acrobat reader) that will allow you to
search in either the index or contents of /DL's online help book.

Start IDL
Now that you know a little about the command structure in the /DL environment you are ready to

actually load the program. To load IDL, the following commands need to be executed:
athena% add 12.410

athena% source /mit/12.410/student/idl_12.410

athena% cd /mit/12.410/student/username

athena% idl
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After executing these commands, you should see some initial messages from the software, and

then a new prompt:

athena$% idl

IDL Version 6.2, Solaris (sunos sparc m32). (c) 2005, Research
Systems, Inc.

Installation number: 98172-22.

Licensed for use by: MIT

****************NOTE FOR Solaris USERS********************
The Motif library supplied by Sun in Solaris 8

requires a patch, available free of charge from
http://www.sunsolve.sun.com, before it will work properly
with IDL. Without this patch, editable text and table widgets
may cause the IDL program to crash. The patch number is
108940-23, for both 32 and 64-bit Sparc platforms.

ER R I O o b I S S o I S S S S S R R O Sk R S SR R Sk S
IDL>

This means that /DL is running.

Displaying an image

IDL has a collection of useful tools for image display and processing, however, you need to
understand what the tools are doing incase the default parameters don’t give you what you
expect. We are going to start with the simple task of displaying an image and playing with the
display scale. There are some programs inside /DL that make this easy, but we want you to
understand the basics of what the programs are doing. We have written tools to help you with the
data analysis for your projects specifically, but they will be covered in more detail in section 6,
“Reducing Your Data”.

First you need to read an image. “FITS” files have two pieces of information in them, (1) the
image itself (which is binary in nature) and (2) supporting information about the file, called the
header (which is asci in nature). The command, readfits, tells IDL to read the FITS file into a
floating point array called "image" and to read the header of the file into a string array called
"header".

IDL> image=readfits('imagename.fits', header)

Next you need to display the image. slide_ image displays the image with a double window,
the window on the left shows the full image at low resolution while the image on the right shows
the full resolution of the image with scroll bars so you can move around on the image (Figure
46).

IDL> slide_ image, image
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X! Slide Image

Full Image Full Resolution

=i

|0 —_ -

Figure 46. Sample of screen display for slide_image with default scaling. The left half
displays the entire image while the right half zooms in on one part of the image. To move to
another part of the zoomed image, use the slider bars on the right and bottom of the
window.

You may also want to know what the minimum and maximum values of pixels in the image. For

example, you can’t see your star in the image that you have displayed, or the star looks odd (as in
the example above). If you change the stretch you might be able to see your object more clearly.

To do this you can use a few handy functions called min and max which gets this information out
of the image array.

IDL> minvalue=min(image)

IDL> maxvalue=max(image)

Or you can do this in one step:

IDL> minvalue=min(image, max=maxvalue)

In this case, max is called a keyword for the function "min" and allows you to get both values
you want with one command. This says, “get the minimum value of the array "image" and put
that value into a variable called minvalue. Also, put the maximum value of the array into a
variable called maxvalue.”

To find out what the value of any array is, type:
IDL> print, arrayname

For example,

IDL> print, minvalue

You might also want to know how big your image is and how it is being read (integer, float,
string etc) by the computer. You can find this out by typing help and the variable name:
IDL> help, arrayname

IDL outputs the arrayname, type and value or array size.

For example:

IDL> a=[2,3,4,5]

IDL> help, a

A INT = Array[4]

Once you have determined the parameters of your image as described above, you can display
your image with those parameters. For example, you might want to change the display values
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used by slide image to see a faint source in your image that did not show up with the default

scaling. Use the “bytscl” function to do this:
IDL> image2=bytscl(image, max=maxvalue, min=minvalue)

This puts the image into another array so that you can use the original again if you want to play
around with different scaling parameters (max and min are the minimum and maximum of the
display that you input as maxvalue and minvalue, not by definition the min and max values
themselves). You may find that shrinking the distance between min and max makes a big
difference. For the image displayed above, min=0 and max=16383. The display below is scaled
from min=0 to max=500. After you have created a new array, display your modified image
(Figure 47):

IDL> slide_ image, image2

X! Slide Image

Full Image Full Resolution

L

| 2 | =

Figure 47. Sample of screen display for slide_image with modified scaling.

If you have want to clear a window you can either close the window in the top left corner or use

the command “wdelete” to delete the last window you displayed.
IDL> wdelete

Another way to display images is by using a program written in /DL called ATv. We’ll test this
with one of the images you have in your Tutorial directory. To open an image using ATV type
the following:

IDL> atv, '/mit/12.410/student/myusername/Tutorial/ps5-07.fits’

If this went well, you should now see a window with the image of a single blurry star in it
(Figure 48). You can adjust the image (as you were doing by hand before) by using the buttons
provided to zoom in and out with your mouse and change the color scaling. If you click on the
image and hold your mouse button down while moving the mouse around you can change the
contrast of the image. When finished, simply click the Done button to get rid of the window.

ATV is also useful for determining what boxsize you want to use for your data analysis.

When you measure the signal or flux in a box around your object, you need to define a box that

is large enough to get all your object signal but small enough not to get lots of background noise.

ATV uses circles instead of boxes (which we use in the class software), but the idea is the same. It

is generally found that making the radius of your box about 2-3 times the full-width-at-half-

maximum (FWHM) of the stars in the image there is a good balance between object signal and
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background noise from the sky. In order to determine the FWHM in ATV you need to click where
it says “mousemode: color” and select the “imexam” option. Now click on a star in your
image. The screen on the right should pop up. If you click on “show radial profile” you
will get the profile that is displayed below the image statistics. In this window below the image
with aperture circles overplotted is a measure of the FWHM. It may be slightly different for
different stars on your image, but click on a few stars and determine the mean. Multiply this
number by 4 to get the boxsize you should use to input to phot in the reduction section of this
manual.

X! atv: ccy_v_02.fits DO C X! atv aperture photometry

File ColorMap Scaling Labels Blink Imagelnfo Help

Hin= |F136,757 I

Hax= | 1073.78

Cursor position: x= 332 y= 347

Centering box size (pix): |5

Object centroid: x= 330,39 y= 346.9

fiperture radius: |16
Inner sky radius: |30

( 320, 240) 73,000
[ -==No UCS Info--- |

s [Eoer _‘l Invert Restretchl RutoScalel FullRange] Outer sky radiuss |0 300 320 340 380
ZoomIn |Zooml]ut| Zooml| Center| Done FUHH (pix)s 7.51
= Sky levels 59,0667
Photometry Settings. .. | | Object counts: 92333.0 |
Hide Radial Profile | Done |

Figure 48. Sample of ATV screen display (left) and ATV aperture photometry screen
display (right). See the text for details about how to use this IDL routine.

If you want to learn some simple methods for plotting things in /DL, turn to Appendix D.
For additional information on other functions in /DL you can explore the IDL help manual by
typing “ 2" at the /DL prompt. This will start up the /DL help manual in Adobe Acrobat.

5.3.2 Mathematica

Mathematica is a powerful application program for doing simple and complex
mathematics and plotting your results. It requires a license to run, but is available to MIT
students on Athena in the “math” locker.

athena% add math
athena% mathematica & (for Notebook/X interface)

or
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athena% math (for TTY interface)

There are many ways to utilize Mathematica. As an end user tool, Mathematica can be
used to carry out either numeric or symbolic computations. It can be used as a programming tool
and has the ability to interface to external programs written in C, Java and other languages. It
also has the capability to create graphics (figures, text, equation etc.) that can be exported for use
in other documents. In this class, we will not be giving instructions for Mathematica, but if you
already know it and want to use it for your project that is fine. Some of the teaching staff (Mike
Person, and Jim Elliot) use Mathematica regularly for their research and can answer questions
you might have while doing your project.

5.3.3 MatLab

MatLab (Matrix laboratory) is an interactive software system for numerical computations
and graphics. It is especially designed for matrix computations: solving systems of linear
equations, computing eigenvalues and eigenvectors, factoring matrices, and so forth. MatLab, is
designed to solve problems numerically in finite-precision arithmetic. Therefore it produces
approximate rather than exact solutions.

MatLab, like IDL and Mathematic, requires a license to run and is available to MIT
students on Athena. It can be found in the “matlab” locker.

athena% add matlab
athena% matlab -ver number (where number is 5.3.1 or 6.5.1)

Again, in this class, we won’t give you instruction in MatLab, but if you already know it
and want to use it for your project it is available to you. If you are trying to fit sinusoids to period
data you may find the Junior Physics Lab MatLab packages helpful.

http://web.mit.edu/8.13/www/index.shtml, and click on “MatLab Curve Fitting”
under “Data Analysis”.

534 IRAF

Image Reduction and Analysis Facility, or more commonly, /RAF is a general image
processing tool. IRAF is a product of the National Optical Astronomy Observatories (NOAO)
and was developed for the astronomical community. It is often used at telescope facilities for
data collection and on the spot analysis as well as more detailed analysis once one has left the
telescope. It runs on all platforms and is free for download from NOAO
(http://iraf.noao.edu/). It requires an X-terminal interface and one of a number of image
display programs (SAOImage, DS9, Ximtool etc.).

IRAF has similar packages to the routines you are using in /DL; however the user
interface does not allow understanding the details of your analyses as easily as the packages we
have written in /DL.
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6 Reducing Your Data

In common language, the terms "data reduction" and "data analysis" are often used
synonymously. In this course, however, we shall use "data reduction" to mean a process
whereby a large amount of data (numbers) are "reduced" to a much smaller set. An example of
data reduction is the extraction of the centers and/or the instrumental magnitudes for the
astronomical images on a CCD frame. The centers and magnitudes would typically be a set of a
few tens of numbers, while the original CCD frame contains hundreds of thousands of numbers.
Further work with the reduced set of numbers is termed "data analysis" and will be described in
the next section.

In this course we support a set of data reduction software that runs in the environment
described in Section 5.3.1, Interactive Data Language (IDL), which you will access through
Athena. The instructions in this section begin with the assumption that you have already
transferred your data to your Athena account (as described in Section 4) and that that you have
started IDL from your Athena account (as described in Section 5.3.1).

6.1 Calibrating Data

This section describes the steps you need to complete to take your images from being
“raw” at the telescope to “calibrated” by subtraction of your bias and dark calibration frames. In
IDL you can type the name of any calibration routine listed below and IDL will print out what
the routine expects as inputs. Things in brackets [] are optional inputs.

In all the following routines the “filelist” is a list of file names and “directory”
only needs to be listed if you are not working in the directory where your files are located. To
make this filelist or add to an existing list, type in IDL:

IDL>$1s filename.fits > output file name.lst

This is also very useful for putting several files on a list at once. For instance, if you
have all of your 30-second light exposures in one directory for a given observation, and wish to
compile them on one filelist before analysis, you may go to that directory and type:

IDL>$1s Light*30S0*.fits > filelist.sample.lst

where a * represents a wild card character, such that all files containing “Light” and “30S0” will
be included. The filelist filelist.sample.lst will now be saved in that directory. To view it, you
may type:

IDL>S$more filelist.sample.lst

filelist.sample.lst—

Light NXXX B1+0C_30S0-1.fits
Light NXXX B1+0C_30S0-2.fits
Light NXXX B1+0C_30S0-3.fits
Light NXXX B1+0C_30S0-4.fits
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You should make filelists for light, dark and bias exposures and may need to separate
them by exposure time and/or filter used. In this way, you may call upon each filelist in the
following routines.

(1) Create master bias frame: makebias
Purpose: This function takes a list of bias images and averages them to make one master bias
image to be used in reducing all of the data for one night.

Calling Example:
makebias, ‘/directory/samplebias.lst’, ‘masterbias.fits’,
[binfac=binfac]

Definitions of Input Parameters:

filelist — (‘/directory/samplebias.lst’) This should be a string pointing to a
textfile that lists all of the files that you wish to use in creating the average bias image. It can
include the path to the images if you want to work in a directory other than the one in which your
images are located.

outfile— (‘masterbias.fits’) This should be a string containing the file name (with
directory) where you want the master bias image to be stored.

binfac — (OPTIONAL) This should be the number of pixels you want to sum in both the x
and y directions on your image. For example if you wanted to bin your image 2x2 you would
specify binfac=2.

Notes: This function doesn't actually display any frames to the screen during its processing or
even after the final image is created. Make sure that your final image is what you expect by
checking your image using either slide image or ATV as described above in the IDL
introduction.

(2) Create master dark frame: makedark
Purpose: This function takes a list of darks images and averages them to make one master dark
image to be used in reducing all of the data for one night for one exposure time.

Calling Example:
makedark, ‘/directory/sampledark.lst’, ‘masterbias.fits’,
‘masterdark30s.fits’, [binfac=binfac]

Definitions of Input Parameters:

filelist —(‘/directory/sampledark.1lst’)This should be a string pointing to a textfile
that lists all of the files that you wish to use in creating the average dark image. Make sure that
all these images have the same exposure time. It can include the path to the images if you want to
work in a directory other than the one in which your images are located.

biasfile — (‘masterbias.fits’) This should be a string containing the full pathname of
the master bias file for use in processing. The master bias file should be created with

makebias.

outfile— (‘masterdark30s.fits’) This should be a string containing the file name (with
directory) where you want the master dark image to be stored.
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binfac — (OPTIONAL) This should be the number of pixels you want to sum in both the x
and y directions on your image. For example if you wanted to bin your image 2x2 you would
specify binfac=2.

Notes: This function doesn't actually display any frames to the screen during its processing or
even after the final image is created. Make sure that your final image is what you expect by
checking your image using either slide image or ATV as described above in the /DL
introduction.

(3) Calibrate data with bias and dark frames: multiccdproc

Purpose: This function takes a list of CCD images (all the same exposure time from one night)
and your master bias and dark files (of the appropriate exposure time), and does all of the bias
and dark subtraction.

Calling Example:
multiccdproc, ‘/directory/calib30s.lst’, ‘masterbias.fits’,
‘masterdark30s.fits’, [binfac=binfac, darkscale=darkscale]

Your input list should have all your images with a given exposure time to match your input
master dark. For example, if you have 30 and 60 second exposures you should have two lists,
one for your 30 second images and one for your 60 second images to match your master darks
files: masterdark30.fits and masterdark60 fits.

Definitions of Input Parameters:

filelist- (‘/directory/calib30s.1lst’) This should be a string pointing to a textfile
that lists all of the files that you wish to calibrate. Make sure that all these images have the same
exposure time. It can include the path to the images if you want to work in a directory other than
the one in which your images are located.

biasfile — (‘masterbias.fits’) This should be a string containing the full pathname of
the master bias file for use in processing. The master bias file should be created with
makebias.

darkfile — (‘masterdark30s.fits’) This should be a string containing the full pathname
of the master dark file (for the exposure time corresponding to your images) for use in
processing. The master dark file should be created with makedark.

binfac — (OPTIONAL) This should be the number of pixels you want to sum in both the x
and y directions on your image. For example if you wanted to bin your image 2x2 you would
specify binfac=2.

darkscale — (OPTIONAL) If you forgot to take a dark for some exposure time, this option
allows you to scale whatever dark you took to the right exposure time for calibration of your
science images. For example if you forgot to take 60 second darks, but took 30 second darks you
would specify darkscale=2.

Notes: This function doesn't actually display any frames to the screen during its processing or
even after the final images are created. You can check your final images using either
slide_image or ATV as described above in the /DL introduction.
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6.2 Getting numbers out of the images

Astrometry and Photometry Routine: phot

Purpose: This function takes a list of CCD images, an output filename and a boxsize. It displays
the image then asks you to click on an object of interest followed by a location for measuring the
background sky (Figure 49). The function does simple box photometry (it adds up all the counts
in the pixels of your box) at both of the locations you defined based on your input boxsize and
writes the results out to a text file, your output filename. It allows you to measure one star on the
frame or multiple. Each successive star is given a serial number from 0-N. The (x,y) position of
your mouse click, the (x,y) position of the object centroid (center of mass of the light) and the
center (X,y) position of your background is recorded to the output file as well. This program also
has an option to allow you to choose your sky background to be determined from a box around
your object instead of from a separately defined region. If you desire to use the function in this
way, then use the /oneclick flag when calling the routine. If you are measuring multiple
objects in a field you may also choose to use the same background for measurement, for this use
the /singleback flag. If you want to be able to make measurements at specific pixels (useful
for projects of fuzzy rather than point sources) then use the /roam flag. This will print out the
pixel coordinates to the terminal window.

Calling Example:
phot, '/directory/path/infilelist.txt’, '/directory/path/outfile’,
boxsize, [min=min, max=max, /roam, /singleback]

If using oneclick, calling example:
phot, '/directory/path/infilelist.txt’, '/directory/path/outfile’,
boxsize, innersky, outersky, /oneclick, [min=min, max=max, /roam]

Definitions of Input Parameters:
filelist —('/directory/path/infilelist.txt’) This is be a string pointing to a
textfile that lists all of the files that you wish to analyze.
outfile—('/directory/path/outfile’) This should be a string containing the full
pathname to a text file where you want the photometry and position results to be stored. If the
file does not exist a new file will be created, if it does exist the file will be appended to. The file
has a header, but for additional reference the columns are recorded as follows and a sample
output is recorded below:
Independent Box background
File, Serial, Mouse:ObjectX, ObjectY, Centroid:ObjectX, ObjectY, BackgroundX,
BackgroundY, Boxside, Background, Object, Object-Background, StdDevPerPixel,
ExpTime, FrameTime
Box around Object background
File, Serial, Mouse:ObjectX, ObjectY, Centroid:ObjectX, ObjectY, InnerSky, OuterSky,
Boxside, Background, Object, Object-Background, StdDevPerPixel, ExpTime,
FrameTime
boxsize - This is the number of pixels on the side of a box that contains the area on the image
that you are summing. It should be an even number; if an odd number is entered, it is set to the
next even number. Your mouse clicks should not be closer than boxsize/2 to the image edge.
See the discussion on ATV to learn about how to determine what your boxsize should be.
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Options:

innersky — This should be an even number, larger than your boxsize. It records the inner
edge of the box for determining background.

outersky — This should be an even number, larger than your innersky. It records the outer
edge of the box for determining background. Remember you want the area of your sky to be as
large as if not larger than your object box.

min, max — display parameters in case the auto scale does not seem to work .

/roam - if you want to see the pixel readout before you click on the image, add this flag to your
command line, it will print out your pixel location of your cursor in the xterm.

/singleback - subtract the same background from multiple sources on an image.
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Sample output file information:

version: 05.06.09

File, Serial, Mouse:ObjectX, ObjectY, Centroid:ObjectX, ObjectY, BackgroundX, Backgroundy,
Boxside, Background, Object, Background-Object, StdDevPerPixel, ExpTime, Date, Time
juno_40_pl 1.fits 000 258.000 225.000 257.854 224.907 314.000 257.000

6 9692.20 365565.22 355873.03 105.02 40.00 2003-10-20 23.562
juno_40_pl_1.fits 001 271.000 295.000 270.857 294.511 315.000 256.000

6 9887.60 57781.80 47894.20 103.25 40.00 2003-10-20 23.562
juno_40_p2_1.fits 000 258.000 224.000 257.925 224.164 314.000 257.000

6 4520.20 357672.50 353152.31 100.53 40.00 2003-10-20 23.586
juno_40_p2_1.fits 001 270.000 293.000 269.998 293.116 316.000 258.000

6 4433.20 51080.80 46647.60 110.53 40.00 2003-10-20 23.586

000 x| ID

Figure 49. Sample of phot display screen with aperture boxes overlaid. See text for
program input parameters and outputs.

Spectroscopy: specextract

Purpose: This function takes a single CCD image, and an output filename (Figure 50). It asks

you to click on a spectrum on the screen, and then click on a background area (near the bottom of
the image). It then extracts the spectrum, subtracts the background and writes column numbers
and flux values to the output file. It puts the output values in a two column text format that can
be loaded into most standard plotting programs for graphing (Excel, Xess, IDL, Mathematica,
Matlab, etc.).

Calling Example:
specextract, '/directory/path/file.fits',
'/directory/path/outfiledata.spec'

Definitions of Input Parameters:

infile— ('/directory/path/file.fits') Name of the image you want to extract your
spectra from.

outfile—('/directory/path/outfiledata.spec') This should be a string containing
the full pathname to a text file where you want the spectrum stored. The format of the output is a
two-column list: pixel, counts.
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X Light_NXXX_B1-10C_550-29.fits

Figure 50. Sample of specextract display screen with spectra extraction regions overlaid.
See text for program input parameters and outputs.

specextract_mod

Purpose: This function takes a single CCD image, and an output filename (Figure 51). It asks
you to click on the top and bottom of your spectral area and sums in columns between the values
you define. It does not subtract any background, but seems to give better results on faint objects.
Using this function you are effectively averaging the spectra from multiple fibers resulting from
specextract. It extracts the spectrum and writes column numbers and flux values to the output
file in a two column text format that can be loaded into most standard plotting programs for
graphing (Excel, Xess, IDL, Mathematica, Matlab, etc.).

Calling Example:
specextract mod, '/directory/path/file.fits',
'/directory/path/outfiledata.spec’

Definitions of Input Parameters:

infile—('/directory/path/file.fits') Name of the image you want to extract your
spectra from.

outfile—('/directory/path/outfiledata.spec') This should be a string containing
the full pathname to a text file where you want the spectrum stored. The format of the output is a
two-column list: pixel, counts.
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X Light_NXXX_| 550-29.fits

Figure 51. Sample of specextract_mod display screen with spectra extraction regions
overlaid. See text for program input parameters and outputs.
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7 Analyzing Your Data

Mac).

You may choose to work in one of the environments already discussed (/DL,
Mathematica, MatLab, etc.), or if you are not familiar with any particular software, we
recommend that you use a spreadsheet program (e.g. Xess on Athena, or Excel on Windows or

Astrometry

1.

Select the standard star (centroid) x,y coordinates out of the file you created with
phot.

2. Use the ra, dec coordinates for these stars to calculate the plate scale and rotation
angle for each of your frames.

3. Use the plate scale and rotation angle from step 2 to solve for the ra and dec of
your object.

4. Complete any farther analysis such as calculation of an orbit.

Photometry

1. Using the output of phot, calculate magnitudes for each of your measurements
(for your object and standard stars)

2. Create an airmass-extinction plot with your standard stars.

3. Use the results from your airmass-extinction plot to calculate calibrated
magnitudes for your object(s) of interest.

4. Plot your results (magnitude vs. time, B-V etc.)

5. Fit models to your results, calculate relevant quantities, etc.

Spectroscopy

1. Determine your wavelength calibration with the argon spectrum. Plot flux vs.
pixel and use the CRC to determine which lines match which wavelengths.

2. Plot wavelength vs. pixel and fit the result with a line to get your transformation
relation.
Apply your transformation relation to the pixels in your spectrum of interest.

4. Plot your results as wavelength vs. flux.

Interpret your results.
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Appendix A: Choosing and Planning a Project

The first step in carrying out your class project is to decide on what your project will be.
Your course project should answer a scientific question with a set of astronomical data that you
acquire with a telescope. After choosing a project, you need to flesh out the basic idea with more
details of exactly what data you need, how you will calibrate the data, how you will reduce the
data, and what analyses you plan to carry out in order to answer your scientific question. This
information should be given in your project plan, which is a written document that you will also
present orally, as part of the communications component of the course.

Choosing a project

Your choice of a project will be constrained by several factors: (i) requirements of the
course, (ii) your own criteria, and (iii) constraints imposed by limitations of the observability of
astronomical objects (only half of the sky can be above the horizon at any given time; trees or
lights may block your horizon, etc.) and the equipment. These are discussed in the following
sections.

Project criteria imposed by the course

The criteria for an acceptable project are simply that your project should answer a
scientific question with a set of astronomical data that should take no longer than 3-5 hours to
acquire under clear skies with available facilities. The results of your analyses should be
quantitative and include a rigorous error analysis.

Project constraints imposed by observability and the available equipment

Will the object(s) that you want to observe for your project be well above the horizon (as
viewed from Wallace Observatory) in the first part of the night during September and October?
Remember that there are trees at Wallace Observatory so the object must be above 20° for at
least three hours on any given night. Are the objects bright enough to give a strong signal with
the available telescopes and instruments? Check the magnitude(s) of the object(s) of interest and
compare with the limiting magnitude of the telescope you will be using. If the answer to either
or both of these questions is "no," you may be able to find other objects of the same type that are
brighter and/or better placed for observation. Consult your lab instructor for help with these
issues.

Your criteria for a project

Be sure to pick a project that you find interesting—either because of the type of object or
the technique that would be used. We expect you to get help from your lab instructor to pick out
a good project. By “good” we mean a project for which it is possible to collect the necessary
data within 3-5 hours and analyze the data to achieve your desired result. We want you to be
successful with your project, and we will tell you if we think a particular project would be too
difficult. However, if we think you have a good basic idea, we may help you modify your
project so that it can be successful within the scope of this course.
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You can ask yourself two questions:

1. Type of object to look at: Do you want to look at solar system objects, at stars or, at
fuzzy things (like galaxies and nebula).

2. Type of measurement: Do you have a preference for astrometry (position
measurements of objects), photometry (brightness of objects), or spectroscopy
(brightness of objects vs wavelength).

Some combinations of objects and measurements make more sense than others, but
responding to these two questions will at least get you pointed in the right direction and give
your lab instructors some ideas about where to direct you in choosing a project. Unfortunately,
some of the projects that you would find most interesting will not be possible because they
would require a larger telescope, better site, or an instrument that we do not have. For example,
measuring the redshift of a galaxy with the equipment available to you would be extremely
difficult (if not impossible). However, if you are interested in galaxies, instead of trying to
measure red shifts you could measure the colors of one or more galaxies and use these data to
infer the relative numbers of different types of stars that comprise the galaxy.

Some suggestions for projects

Below we discuss some ideas for projects, which we have grouped according to the type
of measurements that you would make. Certainly there are more potential projects in each group
than appear below. You can get more information about potential projects through discussions
with the teaching staff and your own investigations of reference materials (library, world-wide
web, and the course hand outs). For a list of useful resources, please see Appendix C. We
expect you to flesh out the details, but keep asking us questions; after all, we love astronomical
observations!

Ideas for astrometric projects

Astrometric projects generally involve moving objects. Although all celestial objects
move relative to each other, only those within our solar system will have enough angular motion
to be detectable during the term. So an astrometric project could be to determine an orbit of an
object—either the orbit of a satellite around a planet or the orbit of an asteroid (a.k.a. minor
planet) around the sun. Since the instantaneous orbit of a body lies in a plane and a plane can be
determined from three points (not collinear) you would need observations at three different times
to establish an orbit. To get good leverage on establishing the orbit plane, however, your
measurements should be spaced in time over the orbit. Satellite periods are of the order of days,
so you can sample an entire orbit during the period of observations for this class. Asteroids, on
the other hand, have orbital periods of years. Over a few weeks you could get a first order
solution for an orbit, or you could improve the accuracy of an existing orbit by combining your
new data with older data.

On any given night you want to take a series of measurements on your object (about ten
frames each time) and then come back another night (your next lab section, or next few lab
sections, for example) to get more measurements of the position of your object. You could do
this with any filter but the R filter gives the strongest signal for most solar system objects. You
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need to make sure that in addition to your satellite or asteroid, there are other objects in each
CCD frame with a known position that you can use to establish a celestial reference frame.

Ideas for photometric projects

Photometry projects are the most diverse. Some photometry projects measure an object
in the same filter vs. time, which you can use to determine the rotation period of an asteroid, or
the period of a variable star. Basically you want a certain amount of time on one night to
observe your object of interest, taking as many images as you can during this interval.

Another idea for photometric project would be to make a Hertzsprung-Russell diagram
for an open cluster, from which you can determine the age of the cluster (see almost any basic
astronomy text for more information). For this project you would pick a cluster and measure the
magnitudes of several stars in different filters (U, B, V, R, and [ are available, but you need only
two).

If you are doing photometry of a galaxy or open cluster instead of sitting on one patch of
sky for the entire night you might want to move the telescope around to different parts of your
object (different parts of your galaxy or different stars in the cluster) throughout the time you are
observing. You don’t need a comparison star in the field but you do need to take standard star
observations as described above so you can get actual magnitudes for the stars you measure. At
each position you should take between 3 and 5 exposures in each filter for both your object(s)
and your standard stars.

For any photometric project you need to calibrate the magnitudes of your objects. For
these you need to measure stars of known magnitudes, called “standard stars.” Standard stars
should be observed before the first observation of your object and after the last observation of
your object. If you are observing with multiple filters you need to make sure you take
observations of your standard star in all the same filters as your object. You should take between
3-5 exposures each time to check the consistency of the results. If you are measuring a rotation
curve you can use the technique of differential photometry, by measuring the light from another
star, which we’ll call a “comparison star” in the field with your object at all times.

Ideas for spectroscopic projects

Spectroscopy is the characterization of a celestial body’s light by wavelength, generally
in order to investigate the composition and/or physical processes of an object. For example, you
might compare the spectral lines of different types of stars to understand what determines these
different types. Or, you could look at the spectral signature of a planet’s atmosphere or surface,
and compare it to what we know about the Earth. Since a spectrum spreads out the light from an
object over many pixels of the CCD, you will need longer exposures with the spectrograph for an
object than with direct CCD imaging through a filter. For fainter, extended sources, you may
need to take a number of observations and add them together to give a solid result. The
spectrograph works in the same basic way as the direct imaging telescopes except instead of
centering your object in the field of view you want to properly align your object with the grating.

For spectroscopy, there are two main calibrations that need to be done: wavelength
calibration, to determine the wavelength of every pixel, and background subtraction, which
accounts for the dark current and CCD bias. It is generally wise to do wavelength calibration
before and after your observations to make sure nothing changed in-between. We do this by
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using an argon lamp for which we know the composition and can match up the wavelengths of
argon to our measurements at different pixel positions.

For more information on astrometry, photometry and spectroscopy, see Sect. 3.3 - Astronomical
Image Data

Collaborations on projects

Although each student should carry out a project individually, limited collaborations can
be of benefit. For example, it two students are interested in making an Hertzspring-Russell
diagram of the Pleiades the project could be accomplished individually with the measurement of
about 15 stars. However, if the two students each collect 15 stars and share their data it is
possible for their final graphs to have 30 points, giving a much stronger result. If you share data
you need to acknowledge the person you have collaborated with in your individual paper and
you also need to include as much information as you can about your assessment of that data — did
you get raw images from your collaborator or data in some stage of reduction (instrumental
magnitudes, calibrated magnitudes etc.).

Choosing Specific Object(s) for Your Project

Once you have chosen the type of project you want to do, it is now time to choose a
specific object to observe. Here are some questions to answer, along with useful resources to
help you find specific targets given the conditions at Wallace. The following is not an
exhaustive list, and you should consult your lab instructor for further input and ideas. As
discussed above, your object should satisfy three criteria. First, and foremost the object should
be suitable for your project goals. For example, if you want to measure an asteroid's light curve,
you must pick an asteroid that has a light curve amplitude of no less than about 0.15 mag or so.
Also, it must have a short enough period to allow reasonable coverage of most phases of the light
curve. Second, your object should be more than 20° above the horizon from early evening for at
least several hours. As a useful first tip, it is highly encouraged to choose an object that is rising
at the beginning of the night rather than setting, so you are less constrained by time. Finally,
your object should be bright enough to give a good signal (brighter than m ~ 10-11).

Choosing an Asteroid

Asteroids are very versatile and popular project objects in this course. Using astrometry, one
may measure an asteroid’s trajectory around the Sun. Using photometry, one may measure the
light curve of an asteroid and obtain its period. Whichever project you may choose, asteroids are
generally reliable objects to observe, but require a several nights of observing time to obtain
good results. Often, you will need to direct your telescope to the asteroid at the beginning of the
night, and take observations periodically throughout the entire observing session. Therefore, you
must choose an asteroid that is above the horizon for a significant amount of time on any given
night between September and October. You may browse websites for Near Earth Objects, or
Main Belt Asteroids. You will need to do some research with Starry Night (Sect. 1.1) to make
sure any asteroid you choose is observable for enough time. For more resources, refer to
Appendix C: Useful Websites.

Choosing a Solar System Planet or Satellite
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Planets and their satellites are reliable objects to observe due to their brightness. However, your
choices are limited for the small window of time given. Use Starry Night (see Section 1.1) to
help you figure out which ones are up on the nights you want to observe. For planets, check the
angular size of the planet and compare that with the CCD’s angular dimensions to make sure the
planet is small enough, should you want to take exposures.

Choosing a Star

Do some research on the types of stars that would be observable with the telescopes available at
Wallace. The following questions may help you get started. What is the magnitude of the star,
and will the star be easily detected given the equipment? If so, which filters, if any, should be
used? If the star is variable, what is the amplitude and variability of the star — do you think this
will be significant enough to detect in a light curve?

Once you have decided on a type of star, you may research (using a combination of books, the
Internet, and Starry Night) to figure out which exact star would be most suitable for the course’s
observing conditions. Generally, variable stars are useful objects to study for photometry
because one can easily build a light curve, if the variable star has a small enough period. Dwarf
Cepheids are convenient to observe because they have short periods and high amplitudes. Any
other type of variable star is good for astrometry or spectroscopy, as long as it has a high enough
magnitude. For more information, visit www.aavso.com.

Recording a Transit of an Extrasolar Planet

Extrasolar planets are relatively recent to the astronomical field, and extrasolar planet transits are
very intriguing to observe. However, they are tricky and require a very detailed observation
plan. Transits occur when a planet passes between its parent star and the observer, partially
blocking the light from the star from reaching the observer. The key is to find a few transits that
occur in September and October, and to be prepared to observe on all of those nights. A
successful observation of a transit only takes one very clear night. However, there may only be a
few transits that occur over a two-month span, and only one of those nights may be clear. There
are also only a few extrasolar planets that are observable in the Northern Hemisphere. Needless
to say, this is an extremely difficult project because the transits have small amplitude (~0.01
mag) and the specific times when transits occur may not be clear. This project should be
attempted only by those with experience.

Other Possible Objects of Interest

Planetary Nebulae (spectra); galaxies.

Planning a project and writing your project plan

The main purpose of your project plan is for you to present your understanding of what
will be involved in achieving the scientific goal of your project to the teaching staff. Then the
responsibility of the teaching staff is to either (i) confirm that your project is feasible within the
scope of the course, or (ii) suggest modifications to your original plan that would result in a
feasible project. Hence, your project plan is an "interface document" between you and the
teaching staff, and as such it should be clearly written. "Clearly written" does not mean that you
completely understand all aspects of your project at the beginning. It does mean that the written
document explains what you do understand about your project, and it also raises questions about
those aspects of the project that may be somewhat unclear to you.
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The process of planning your project and the process of producing a written plan to
submit to the teaching staff can (and should) be a combined activity. As you learn more about
what your chosen project involves, in terms of what data you need and the subsequent data
processing, you will be making notes for yourself. These notes can then be grouped together into
an outline, and then the outline can be expanded into a written document. The level of detail
expected is about what can be written in 3-5 pages (excluding display items, such as tables,
figures, and equations).

Your plan should begin with the scientific question that your project will try to answer.
This should include a brief description of why the question is of scientific interest to both you
and others in astronomy or related fields. This might include a brief discussion of the science
behind your project and what your project hopes to add to what is already known. If you expect
certain results you should describe those and if there are challenges associate with your project
(data collection or analysis) you need to write about this as well.

Following the definition of your project, you will need to address what data will be
needed to answer the question. We do not expect the exact details of every exposure that you
plan to record, but we do need to know: what instrument you plan to use (i. e. a CCD camera
with direct imaging or spectrograph), if you need a particular telescope in the shed, what objects
you plan to observe (will they be visible from Wallace Observatory this time of year?), and what
calibration data (both sky and detector) you will need. The fainter the object, the longer the
exposure times need to be to achieve an acceptable result (we will help you to estimate exposure
times). The total amount of data for your project should fall in the range of 3-5 hours.

After specifying the data to be recorded, plans for reduction and analysis should be
discussed. Much of the reduction software supported by the course is described in this manual —
you can assume that the software exists and will function as advertised. Please describe the
processes as you understand them in the software, rather than just saying that you will use the
class packages to get numbers from your images. We want to know that you understand what the
software is doing not what code you are running. Analyses have (purposely) not been described
in detail in this manual, so that you can insert your own ideas and skills.

Although we have not given detailed information in this manual, the teaching staff would
be pleased to help you develop your own ideas about how you would like to analyze your data,
and to discuss the feasibility of what you want to do. Again the details of your plans for data
analysis do not have to be known at this point.
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Appendix B: Project Plan Guidelines

The purpose of the communication component of 12.410 is to support you in the writing and
speaking aspects of being the best scientist you can be.

We want all of your projects to be successful. We also want you to experience the maximum
possible learning—in astronomy as well as in proposal and report writing, presentation, and peer

review.

The Project Plan Writing Process

What?

When?

Why?

How?

A 3- to 5-page telescope proposal (excluding Figures and Tables)
A 5-minute oral presentation

Consult the course Stellar web site for the due dates of your Project Plan, the revison
to your Project Plan, and the oral presentation of your Project Plan.

The process of writing, presenting and revising your project plan serves several
purposes:

1.

4.

It gives you experience with writing a proposal to request telescope time, which is
a kind of document commonly used by astronomers.

It helps you determine what you want to accomplish and what questions you need
to answer before you begin your project.

It gives your teaching staff an opportunity to evaluate whether your project is
feasible and, if necessary, to help you modify it.

It fosters a professional aspect to your relationships with your peers.

Organize your plan in three parts:

Goals and Purpose
Describe in a few paragraphs what you intend to do and how your project might

be of use or interest to other astronomers. Pose as clearly as possible the
scientific question your project will address. Present any background information
that will help you and your readers understand and contextualize your question
and results, including the underlying science and anything you hope your project
will add to what is known.
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If you expect certain results, describe them along with your reasoning for
expecting them. If you foresee challenges associated with your data collection or
analysis, identify and discuss them as best you can.

You are not expected to have all the answers, or even to predict all the relevant
questions. The more you can identify unknowns or potential problems, though,
the better the staff can help you design and plan a successful project.

Observation Plan

List the object(s) you will observe, their locations and time in the sky, the
equipment you will need, and approximately how much time you will need with
that equipment (assuming no major problems arise).

You should require in the range of 3 to 5 hours of telescope time to complete the
data collection for your project.

Part of the purpose of this section is to aid your planning. Another part is to aid in
the scheduling of equipment. So please include as much information as you can
about what instrument(s) you will need, whether you need a particular telescope
in the shed, what objects you plan to observe, and what calibration data (both sky
and detector) you will need.

Your requests will be coordinated with all of the other projects on both teams.

Analysis Plan
Discuss your plan for reducing, presenting and analyzing your data.

The focus should be on what point you expect to make and what conclusions you
will generate, including but going beyond identifying the software packages you
expect to use. You will want to describe how you will use a given software
package, what results you expect, and how those results relate to your research
question. Elaborate detail is not required.

If you have any questions about how to do the science or the writing, please ask your staff.
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Appendix C: Oral Presentation Guidelines

The purpose of presenting your Project Plan to the class is to give you practice in communicating
your work effectively and professionally, and in fielding questions to get the maximum value
from your staff and peers.

Whatever your future holds, a significant component of it will almost certainly be presentations
of your work. Many people do not particularly like giving presentations, but almost everyone

can become proficient, reasonably confident, and effective.

In conjunction with your written work, we will learn about how to produce and use effective
visual material.

In addition, we will work on the art of eliciting helpful questions from your audience, and
answering them with poise. When you are effective with Q&A, your presentations become
opportunities not just to deliver your work, but also to learn, explore and expand your
understanding.
What? A 5- to 6-minute presentation of your Project Plan

Approximately 5 slides derived from your Plan

Approximately 2 minutes of Q&A
When?  Check the Stellar web site for the date of your oral presentations.
Why? Presenting your project plan serves several purposes:

1. It helps you focus your thinking.

2. It provides immediate feedback on your preparation.

3. It gives you an opportunity to consider others’ questions, thoughts, and ideas about
your Plan, and to explore things you may have missed.

4. It helps you build confidence, both about your work and about your ability to express
it professionally.

How? Further details about the content and delivery of your presentation are posted online.
The essential points:

Prepare to be brief
Five minutes is not long. You will not cover everything. Select wisely.
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Craft your visuals carefully
As a rule of thumb, use one slide for each minute of speaking. Make sure your

slides are easy to read. Select slides that focus on essential points.

Practice out loud, repeatedly, and in front of a mirror
You talk to yourself at a different rate than you talk in front of a room. Practice
out loud. If possible, record or observe yourself.

Pay attention to, and address, your audience
Do they understand you? Are they interested? Are they pondering? Work with
them. Talk to them. Put yourself in their shoes.

Prepare for questions
Questions can illuminate strengths and weaknesses of your Plan, and help you

develop your work. The way in which you elicit and respond to questions can
have an effect on the quality of questions you elicit.

If you have any questions about your oral presentations, please ask your staff.
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Appendix D: Project Report Guidelines

This document describes what we are expecting in your project report. Simply stated, your report
should describe to a knowledgeable person (e.g. your lab instructor, lecturer, or fellow student):
1) what you set out to do and perhaps something about why;
(i1) what you did (procedure, data, reduction & analysis methods, results); and
(ii1))  what you learned (conclusions).

There is no set requirement as to length; write as much as you need to in order that your audience
have a clear understanding of your project. The written portion, if concise, could be as short as
10 to15 double-spaced pages, plus tables and figures. Clarity and coherence are more important
than page numbers.

A good Project Report has many variables. The Mayfield Handbook of Scientific and Technical
Writing, written for use at MIT, offers clear and succinct advice and requirements.
(http://web.mit.edu/writing/temp2/home.htm).

Detailed information about the content, structure, and style of your Project Report will be posted.
Some essentials follow.

Organization
Below is one example of a typical organization for a Project Report.

ABSTRACT: a concise statement of the project (half a page or so, single-spaced), including the
most significant results and conclusions. A reader should be able to determine from the abstract
whether to read the entire report. It answers questions such as, “What is this about?” or “What
makes it important or interesting?” or “How does this research fit the current state of
knowledge?”

INTRODUCTION: a summary of how you began the project. A good introduction addresses
issues such as what question(s) you set out to answer, what motivated you to do the project, what
approaches you considered, and your reasoning for the approach you ultimately chose. It
includes enough background information so that your audience (your peers and teaching staff)
can follow your work without undue effort. The introduction is often written after the rest of the
report, and is a particularly good section to ask others to comment on.

OBSERVATION: a description of what you did, providing enough detail so that someone
reading it could reproduce your work. This section generally includes, but is not limited to,
detail about the specific equipment you used and why. It may also include difficulties you
encountered and how or whether you overcame them.

Your observation section will probably include a table summarizing your observations, and may
include a figure illuminating the thinking behind your method.
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DATA REDUCTION: an explanation of how you went about analyzing your data. What
software did you use? What equations did you use? What intermediate results did you arrive at?

RESULTS: a description of the results you did, and did not, achieve. Were your expectations
met? Did you have any surprises? Did you reject any data? Did you confirm anything, or did
your data suggest any rethinking of prior work?

CONCLUSIONS: a summary of what your report suggests or reveals. What did you learn?
How was your initial, introductory question answered (or not)? What other questions arose?
What might you have done differently? What questions are left outstanding? What next
questions are suggested by your results?

Figures, Tables, and Equations

One essential component of your Project Report will be the figures, tables, and equations that
illustrate your work. A reader should be able to grasp the essential points of your report just by
studying your visuals and reading the captions.

Selecting or creating the best ways to visualize information is a complex task. You will probably
learn a lot from studying others’ examples. Another good way to learn about the visual display
of information is to show your draft figures and tables to others for comment.

Label and caption your visual elements clearly and informatively. Each caption should
thoroughly summarize the contents and implications of the figure.

Give only the essential equations. Spell out the variables in your text, before inserting the entire
equation, so that your reader understands it easily.

References and Citation Protocol

The citations in your report are expected to conform to professional standards. This means that
all the material used in your report should be properly cited, with two exceptions: that which is
your own creation, and that which is common knowledge.

Before you begin writing, read and thoroughly understand MIT’s Handbook of Academic
Integrity (web.mit.edu/due/handbook.pdf). This document makes abundantly clear when and how
to use citations. Make sure you understand plagiarism in depth, including the proper use of
paraphrasing.

In professional writing, citations serve several purposes. They allow your reader to pursue some
aspect of your work in more depth by delving into the sources that you have drawn on. In
addition, they give credit to others for the work upon which you are building, just as you would
expect your work to be credited by others.
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For this paper, use the citation style found in Icarus. (Note that preferred citation style varies
among disciplines and even between journals.)

When referencing another’s work within your report, place the citation at the end of the relevant
passage, in author-year format, e.g., (Smith 1998), or (Clark et al. 2000).

Each author-year citation within your report should correspond to a full reference in a References
section at the end of your report. A bibliography containing the references you used is not a
substitute for proper citations.
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Appendix E: Telescope Specifications

Information about the telescopes and available instruments at the George R. Wallace
Astrophysical Observatory can be found at the wuniversal record locator (URL)
http://web.mit.edu/wallace/ShedIndex.html.
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Appendix F: Useful Websites

Class web page: http://stellar.mit.edu/S/course/12/fa07/12.410j/index.html
Wallace Astrophysical Observatory: http://web.mit.edu/wallace/

Finder Charts

VizieR Service: http://vizier.u-strasbg.fr/viz-bin/VizieR

Digitalized Sky Survey: http://archive.stsci.edu/cgi-bin/dss_form

USNO Image and Catalog Archive: http://www.nofs.navy.mil/data/FchPix/
Skyview: http://skyview.gsfc.nasa.gov/cgi-bin/skyadvanced.pl

Asteroid Information

Asteroid Services: http://asteroid.lowell.edu

JPL Horizons (Ephemeris service for minor planets): http://ssd.jpl.nasa.gov/cgi-bin/eph
Koronis Family Asteroid Project: http://www .koronisfamily.com

Minor Planet Center: http://cfa-www .harvard.edu/iau/mpc.html

Star Information
Data Access: http://www-gsss.stsci.edu/support/data_access.htm
Standard Stars: http://plato.phy.ohiou.edu/~tss/ASTR410/standards.html

Astronomy Reference

Astronomy Articles: http://adsabs.harvard.edu/abstract_service.html
Students for the Exploration and Development of Space (SEDS):
http://www .mit.edu/~mitseds/resources.html

Space Science Missions: http://spacescience.nasa.gov/missions/index.htm
Heaven’s Above: http://www.heavens-above.com/

Spectroscopy
Calibration: http://www physics.arizona.edu/~haar/ADV_LAB/spec?2.txt

Introduction: Getting the Most from a CCD Spectrograph by Sheila Kannappan and Daniel
Fabricant. Sky & Telescope. July 2000. p. 125-132.

Boston Weather Information

Satellite Information: http://www .rap.ucar.edu/weather/satellite/

Clear Sky Clock: http://web.mit.edu/wallace/CSC.html

National Weather Service:

http://www .srh.noaa.gov/data/forecasts/MAZ00S5 .php?warncounty=MAC019&city=Westford

Software Tutorials

IDL: http://www .ugastro.berkeley.edu/tutorials/tutorials.html

Mathematica: http://library.wolfram.com/conferences/devconf99/withoff/index2.html
http://web.mit.edu/acs/www/numerical .html

MatLab: http://web.mit.edu/afs/athena/software/matlab/www/home.html
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IRAF: http://aci50.astronomy.pomona.edu/common/webdocuments/iraf/beg/beg-intro.html

Astrometry
Introduction: http://cfa-www .harvard.edu/iau/ps/info/Astrometry.html

Photometry
Of Asteroids: http://www.minorplanetobserver.com/astlc/PhotometryGuide.htm

Updated: 2004-09-07
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Appendix G: Plotting with IDL

Reading a file with columns of data

There are a few ways to read a text file with /DL. The simplest method is described
below, other ways can be looked up in the IDL help. This method assumes the file is column
delimited. There is a handy function in /DL called readcol which will read information from a
textfile based on a few simple inputs. readcol assumes all the values in your file are floating
point unless you tell it otherwise.

If you want to read a string you need to define the array first:
IDL> arrayl=""

To read a file then type:
IDL> readcol, 'filename', arrayl, array2, array3, format='(a,f,f)'

This tells IDL to open the file called filename and to read all the lines that have three
columns: the first column is defined to be a string and the second and third columns are floating

point numbers. If you want to skip a column in your file you can put an “x” in the format
statement, format="'(a,f,x,f)"'.

Plotting arrays

Once you have information from your text file in arrays you will likely want to plot your results.
For example, you can read in a file that looks like:

Jjuno_photometry.txt
File, Serial, Background, Object, Object-Background, StdDevPerPixel, ExpTime, FrameTime
juno_40_pl_1.fits 000 9692.20 365565.22 355873.03 3780.72 40.00 23.5622
juno_40_p2_1.fits 000 4520.20 357672.50 35315231 3619.08 40.00 23.5858
juno_40_p3_1.fits 000 5075.20 354466.81 349391.62 222419 40.00 23.6281

then plot your object-background signal vs. time (Figure 52). To do this execute the following
set of commands:

IDL> readcol, ‘juno_photometry.txt’, imagename,serial,back, object,
object back, error,exptime,frametime, format='(a,a,f,f,f,f,£f,a)’,
delimiter=","

IDL> plot, frametime, object back, psym=4, xtitle='time (hours)’,
ytitle='flux (object-background)’, title='Juno lightcurve’

plot takes two arrays for x and y.

psym defines the type of point you want plotted (if you want it to plot a line you can use
linestyle instead of psym where different numbers are used for different types of
lines, dashed, dotted etc.), in this case diamonds.

xtitle is the label for the x-axis

ytitle is the label for the y-axis

title is the title of the plot.
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There is a lot more power to this command, but that is left for you to explore on your own.

X! IDL O
Juno lightcurve

Figure 52. Sample of screen plot in IDL. Notice that the plot has a title and both axes are
labeled.

Lastly, you might want to plot error bars on your measurements (Figure 53). The command for
that is similar to plot:

IDL> ploterror, frametime, object back, error, psym=4, xtitle=’'time
(hours)’, ytitle='flux (object-background)’, title=’'Juno lightcurve’

Here we’ve added one more array, “error”, before defining the point style for plotting. NOTE:
remember that the "error" in the output file is per pixel so you need to multiply by the boxsize
for the values to be correct.

X! IDLO
Juno lighteurve

Figure 53. Sample of screen plot with error bars in IDL. Notice that the plot has a title and
both axes are labeled.
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Creating a Postscript file of your plot

You may want a hardcopy of your plot. To do this you need to tell /DL to output to a postscript

file rather than to the display. To do this you use the /DL command set_plot.
IDL> set plot, ‘ps’

Now, rerun your plot command:
IDL> ploterror, frametime, object back, error, psym=4, xtitle='time
(hours)’, ytitle='flux (object-background)’, title='Juno lightcurve’

You can make as many plots as you like. Each plot will print to a different page in the default
output file “idl.ps”.

If you want to see your results on the screen again you need to reset the plot to the display:
IDL> set_plot, ‘X’

You can switch between these two displays as many times as you like. Once you are finished
printing things to the postscript file, however, you need to close the file. To do this you need to

exit IDL.
IDL> exit

You should now see a file in your current directory called idl.ps. This is the output of your
plot(s). You can now print your plots to the default printer by typing:
athena% lpr idl.ps

At this point you should also rename your file to something more useful. If you leave it as
idl.ps it will get overwritten the next time you plot from /DL. For the sample data in this

section you might want to name your file “juno_lightcurve.ps”. You can do this by typing:
athena% mv idl.ps juno_lightcurve.ps

Once you have created a postscript file, if you would like to look at it on the screen before
printing, use ghostview on Athena, Figure 54:
athena% gv juno_lightcurve.ps

X! gv: Graphics produced by IDL

File State| | Page | Portrait|| 1.000 || BBox || Graphics produced by || Tue Aug 17 15:24:18 2¢

[ arishiolokeo Juno lightcurve
-1.8 T T T T
Open
Print Al =20 % ]
Print Marked ~ %
2
Save All T _22H -
CEC ] - 4
Save Marked KA |
K 4
2 241 E
c 4
g
E F
ool || 2 2f ]
S F B
[ B
Redisplay = [ ]
0 —3.0L 1 L ! 1 1
-0.5 0.0 0.5 1.0 1.5 2.0
time(hours)
4

Figure 54. Sample of ghostview display of postscript file. With this program you can check
that you printed what you expected to your file and also print your figures to hardcopy.
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Creating a .tiff image from your fits file

fits2tiff, fits2tiffr

Purpose: This function takes a single CCD fits image and converts the file to a .tiff image so that
you can put it in a word document or print it as a pretty picture. There are two versions, the first
(fits2tiff) assumes you want the same size output file in both dimensions, the second (fits2tiffr)
assumes you want different dimensions in x and y.

Calling Example:
fits2tiff, file, outsize, centerx, centery, min, max
fits2tiffr, file, xsize, ysize,centerx, centery, min, max

Definitions of Input Parameters:
file—('/directory/path/file.fits') Name of the image you want to convert
outsize — boxsize for your output file around a center coordinate.
xsize, ysize — dimensions in each direction, x and y, respectively for the output image
centerx — center "X" coordinate of extracted image.

N N

centery — center "y" coordinate of extracted image.
min, max — limits on stretch of image

Calculating instrumental magnitude and errors from PHOT file

This section describes how to go from the output file created by the phot IDL routine to
instrumental magnitude measurements with error bars.

Before beginning, let us define some terms. The output of phot contains several columns of data,
the four most relevant for our discussion being Background, or the sum of the pixel values in the
background frame, which we call B here; Object, or the sum of the pixel values in the foreground
frame, which we call F here; Object-Background or F-B, which we call S here; and
StdDevPerPixel, which we call 6, here. We define N to be the number of pixels in the
background frame, and N;. to be the number of pixels in the foreground frame. For this class,
Np=Ng, typically. We let At be the integration time of a single image, and m, be our label for
instrumental magnitude. Finally, the error in a quantity x will be labeled as Ax.

Error in the signal: The variance of S, the signal, is due to two independent sources: random
background noise, and photon counting noise. Since S=F-B, the variance due to random
background noise is 65> + 05”. The photon counting noise is governed by Poisson statistics, and
so its variance is given by (\/S)Z(see eq.~(5.9) in the class notes). Putting these all together

2
yields: o; =0} + 0, +(\/§) =0;+0,+S.
The variance in F and B is

(V:o,)

2
N,o
o, = =N,0, and Gézu

F B
(see eq.~(5.26) in the class notes). Finally, putting this all together, the variance in S is
0;=N,0,+N,0.+S5
This yields an estimate of the error in the measurement of S of

_ 2
- NBo-p

Department of Earth, Atmospheric, and Planetary Sciences and Department of Physics
Massachusetts Institute of Technology
labManual.61.doc Page 108 of 111



38 =+o; =\/NFG; +N,o,+5S

Error in the instrumental magnitude: Instrumental magnitude is defined as

m, =-2.5log,,(S/At)=-2.5In(S/Ar)/In10,
where S and At are defined as above. To get the error in m, Am, based on the error in S, AS, we
need to propagate our errors (see eq.~(6.7) in the class notes):

o -5 e 45

Plugging in for m, from above,

oS.

25 08
m, = ———
In10 S
Summary: The preceding brief discussion succinctly summarizes all the steps necessary to
calculate error bars based on your data. Furthermore, it is complete, and contains all the
definitions and equations required to go from the output of phot to magnitudes with error bars.
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Sample code for simple magnitude calculations and plots

The following is a sample of the type of things you might want to do with your data for your
project. What follows is only a sample and if used should be tailored to your individual needs.
You can copy the following to a file called "batch.pro" and run it by typing:

IDL> @batch.pro

on the command line. This works as a script as long as you don't use any for or if statements. To
run code with these you need to uncomment the line at he beginning of the code that says "pro
batch" and at the very end of the file that says "end". You run that by typing in the IDL
command line:

IDL> .r batch.pro
then
IDL> batch

Each line that is not commented out will be executed.
; a semicolin is a comment line

; pro batch

; read the data in from the output file

readcol, 'sample.out', imagename ,serial box, back, object, $

object_back, error,exptime.frametime, format='(a,a,x ,x,x,x,x,x,f,f,f.f.f f.a)", delimiter='",

; calculate magnitude, add 24 so that the numbers are easy and not confusing to deal with
mag = -2.5*alog10(object_back)+24.
print, mag

; calculate the flux errors and convert to magnitude
boxerror = Sqrt(boxA2.*error+box”2 .*error+object_back)
print, boxerror

magerror = (2.5/alog(10))*(boxerror/object_back)
print, deltamag

; Plot data with no error bar
plot, time, mag, psym=4, xtitle="time (h)', ytitle="instrumental magnitude', title='Sample Plot'

; Plot data with error bar
ploterror, time, mag, magerror,psym=4, xtitle="time (h)', $
ytitle="instrumental magnitude', title='Sample Plot'

; Plot with a specific range (all positive numbers)
plot, [10,15], [2,3], /nodata
oploterror, time, mag, magerror, psym=4

Department of Earth, Atmospheric, and Planetary Sciences and Department of Physics
Massachusetts Institute of Technology
labManual.61.doc Page 110 of 111



; Plot with magnitudes, brighter up -- you kind of have to trick it
plot, [0,0], [0,0], /nodata, xrange=[0,10], yrange=[0,-3], $
xtitle="time (h)', ytitle="insturmental magnitude'

oploterror, time, mag, magerror, psym=4

; select a particular serial number and plot it

z=where(serial eq 1)

; make sure there are objects with this serial number, the values that
; come back are indices to your arrays

print, z

ploterror, time[z], mag[z], magerror[z], psym=5

; another example

; make sure your error calculation is correct

z=where(serial eq 0)

y=where(serial eq 1)

ploterror, time[z], mag[z]-mag[y],Sqrt(magerror[z]"2.+magerror[y]/2.), psym=4

; Plot options, PSYM Value
;1 = Plus sign (+)
;2 = Asterisk (*)

;3 = Period (.)
;4 = Diamond
;5 = Triangle
;6 = Square
7=X

;end
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